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Вступ 

У сучасному проектуванні електричних систем важливу роль 

відіграють сучасні системи автоматизації проектних робіт. Їх 

застосування підвищує швидкість та якість виконання 

проектування, а також зменшує навантаження на 

проектувальників при виконанні рутинних операцій.  

Методичні вказівки до виконання лабораторних робіт з 

навчальної дисципліни «Проектування електричних схем» 

містять необхідний матеріал для здобуття студентами 

практичних навиків використання сучасних систем 

автоматизованого проектування при розробці різноманітної 

конструкторської та проектної документації. Під час виконання 

лабораторних робіт студенти здобудуть досвід, який допоможе 

при виконанні реальних проектів електричних систем різних 

галузей промисловості.  

У лабораторних роботах розглянуто приклади 2D та 3D-

моделювання, особливості проектування і розробки 

документації (схем і звітів) на електроустаткування з 

використанням програм AutoCAD, AutoCAD Electrical, 

КОМПАС-Электрик (безкоштовна пробна версія) та 

проектування елементів інтегральних схем з використанням 

мови VHDL. Під час виконання лабораторних робіт 

використовуються ліцензійні програмні продукти від компанії 

Autodesk (США), які надані за безкоштовною програмою для 

освітніх закладів «Education community». Завдяки цьому, 

студенти можуть безкоштовно використовувати програмні 

продукти компанії Autodesk, як в навчальних лабораторіях так і 

на власних ПК. 
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Лабораторна робота №1 

Тема: Основні правила оформлення технічної документації  

Мета: Набути практичні навиків оформлення креслення в 

середовищі креслярсько-графічного редактора AutoCAD. 

Навчитися створювати креслення та заповнювати основний 

напис. 

 

Теоретичні відомості 

Схеми є конструкторським документом, на якому показано у 

вигляді умовних зображень або позначень складові частини 

виробу (установки) і зв’язки між ними. Загальні правила 

виконання схемної документації регламентуються державними 

стандартами, зокрема: ГОСТ 2.701, ГОСТ 2.702, ГОСТ 2.721-74 

та ін. Поряд з українськими стандартами, також можуть 

застосовуватися розробки, які виконані на основі зарубіжних 

стандартів, зокрема, американських - ANSI, IEEE, європейських 

- DIN, ÖNORM та інших, які дещо відрізняються від 

вітчизняних. 

Схемна документація включає схеми різних видів і типів, 

переліки і умовні графічні зображення (УГЗ). Види і типи схем 

та правила виконання схемної документації встановлюються 

групою стандартів ЄСКД «Правила виконання схем». Вони 

визначають комплектність, вимоги і правила розробки й 

оформлення схемної документації на вироби всіх галузей 

промисловості, як ручним, так і автоматизованим способом. 

При оформленні будь-якого креслення (кресленика) слід 

дотримуватись таких правил: 

1. Креслення виконують на аркушах паперу визначених 

розмірів (формату), який визначається державним та 

міжнародними стандартами оформлення, наприклад ISO 216. 

2. Формат листа на кресленні визначається розміром 

стандартних аркушів паперу. Внутрішня рамка створюється за 

допомогою суцільної основної лінії на відстані 20 мм від лівої 

сторони і на 5 мм від решти сторін (рис. 1.1). 
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Рис. 1.1. Загальний вигляд внутрішньої рамки креслення 

 

3. Креслення оформлюють за допомогою спеціальної 

таблиці, яку наносять у внутрішньому полі аркушу праворуч 

знизу – кутовим штампом (основний напис), а також 

додатковими графами (рис. 1.2). Державним та міжнародними 

стандартами встановлено: форму, розміри, зміст, розташування 

граф основного напису, а також розміри рамок на кресленнях і 

схемах. Рамку і графи виконують суцільною основною лінією. 

Кутовий штамп виконується суцільною товстою та суцільною 

тонкою лініями. 

4. Формати аркушів (за винятком А4), можуть 

розташовуватися, як горизонтально так і вертикально, але 

формат А4 може розташовуватися лише вертикально. 

5. У правому нижньому куті аркуша міститься основний 

напис (кутовий штамп), розміри якого згідно з ГОСТ 2.104-2006 

наведені на рис. 1.3. 
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Рис. 1.2. Вигляд кутового штампу та додаткових граф на 

кресленні: 1 – кутовий штамп, 2 – додаткові графи 

Рис. 1.3. Розміри кутового штампу згідно з ГОСТ 2.104-2006 

 

У графах штампу (на рис. 1.3 наведені в дужках) вказується:  

(1) – назва кресленика відповідно до змісту роботи; 

(2) – назва навчального закладу, шифр групи; 

(3) – номер варіанту (шифр студента, № залікової книжки);  

(4) – прізвища виконавця та перевіряючого; 
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(5) – підписи осіб, прізвища яких зазначені в графі 4;  

(6) – дата виконання; 

(7) – матеріал з якого виготовлено деталь (якщо потрібно);  

(8) – маса деталі (якщо потрібно); 

(9) – мірило зображення (масштаб); 

(10) – порядковий номер аркуша (за умови виконання 

кресленика на кількох аркушах); 

(11) – загальна кількість аркушів у роботі (за умови 

виконання кресленика на кількох аркушах). 

6. Усі написи на креслениках виконуються креслярським 

шрифтом, розміри якого та накреслення літер, цифр та знаків 

встановлює ГОСТ 2.304-81. Згідно з вимогами стандарту 

застосовують шрифт без нахилу та з нахилом під кутом 75° до 

горизонту. На креслениках усі написи рекомендовано 

виконувати з нахилом літер, цифр та знаків. 

7. Кресленики виконують дотримуючись певних пропорцій, 

тобто масштабу (ДСТУ 2.307:2013). На аркушах формату А4 ці 

написи роблять вздовж короткої сторони аркуша, а на аркушах 

інших форматів вони можуть бути орієнтовані, як уздовж 

короткої, так і вздовж довгої сторони аркуша. Текстові написи 

завжди наносяться паралельно основним. 

Для створення внутрішньої рамки креслення та кутового 

штампу в системі AutoCAD (різних версій) використовують 

графічні примітиви: Відрізок, Полілінія та інші. 

Для побудови графічного примітиву Відрізок (Line) 

застосовують різні способи, які описані нижче. Способи 

введення команди: 

 Набрати з клавіатури команду: _line (ОТРЕЗОК).  

 Викликати з командного меню: Draw > Line (Рисование > 

Линия) – класичний AutoCAD. 

 Натиснути кнопку  на панелі інструментів. 

Щоб побудувати відрізок, необхідно вказати координати 

двох точок – початкової і кінцевої. При цьому будується 

одинарний відрізок або послідовність відрізків. При побудові 

послідовності відрізків кінцева точка попереднього відрізка є 

початковою для наступного. Для побудови виконують таку 

послідовність: 
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1. Введіть команду одним із вище перерахованих способів. 

2. На запит системи Specify first point (Первая точка) ввести 

координати початкової точки одним з таких способів: 

 інтерактивне (динамічне) введення – помістити покажчик 

у вигляді перехрестя в точці, що має потрібні координати і 

натиснути ліву кнопку миші; 

 ввести координати початкової точки з клавіатури; 

 натиснути клавішу Enter, в цьому випадку, як початкову 

точку система автоматично вибере останню точку відрізка, 

побудованого попередньою командою або видасть повідомлення 

про помилку, якщо така точка відсутня. 

3. На запит системи Specify next point or [Undo] (Следующая 

точка или [оТменить]) ввести координати кінцевої точки одним 

з таких способів: 

 помістити покажчик у вигляді перехрестя в точці, що має 

потрібні координати і натиснути ліву кнопку миші; 

 ввести координати кінцевої точки з клавіатури. 

4. На запит системи Specify next point or [Undo] (Следующая 

точка или [оТменить]) виконати одну з таких дій: 

 завершити виконання команди, для цього натисніть клавішу 

Enter; 

 ввести координати кінцевої точки наступного відрізка 

одним із способів, що описані в 3 кроці; 

5. На запит системи Specify next point or [Close/Undo] 

(Следующая точка или [Замкнуть/оТменить]) виконати одну з 

таких дій: 

 ввести координати кінцевої точки наступного відрізка 

одним із способів, описаних в 3 кроці; 

 завершити виконання команди одним із способів: 

a) натиснути клавішу Enter; 

б) ввести опцію Close (Замкнуть) з клавіатури. Опція також 

доступна після натискання правої кнопки миші. При цьому буде 

побудований відрізок, який сполучає останню точку з 

початковою точкою першого відрізка; 

в) якщо ви не завершили виконання команди, то 5-й крок 

повторюється необхідну кількість раз. 
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Дуже часто для вказівки точки початку та завершення 

відрізку виконують за допомогою миші, при цьому потрібно 

вказати напрям і ввести потрібну довжину (рис. 1.4). 

 

 
Рис. 1.4. Використання швидкого вводу відрізків 

 

Для побудови графічного примітиву Полілінія (Polyline) 

застосовують способи, які описані нижче. Способи введення 

команди: 

 Набрати з клавіатури команду: _pline (ПЛИНИЯ). 

 Виклик з меню: Draw > Polyline (Рисование > Полилиния) 

– класичний AutoCAD. 

 Натиснути кнопку  на панелі  інструментів. 

Полілінія складається з послідовності лінійних та дугових 

сегментів, кожен з яких може мати визначену ширину. Значення 

ширини в початковій точці сегмента може відрізнятись від її 

значення в кінцевій точці. При побудові полілінії необхідно 

визначити початкову точку у відповідь на запит системи Specify 

start point (Начальная точка). Далі стають доступними 

параметри у командному рядку при запиті системи Следующая 

точка или [Дуга/ Замкнуть/ Полуширина/ длИна/ Отменить/ 

Ширина]: 

 _arс (Дуга) – створення дугового сегмента полілінії; 

 _close (Замкнуть) – з’єднує кінцеву точку полілінії з її 

початком прямолінійним сегментом; 

 _halfwidth (Полуширина) – задає половину ширини 

сегмента полілінії в початковій та кінцевій точці; 

 _length (Длина) – створює сегмент полілінії заданої 

довжини того ж напряму, що і попередній; 
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 _undo (Отменить) – видаляється останній побудований 

сегмент; 

 _width (Ширина) – задає ширину сегмента полілінії в 

початковій та кінцевій точці. 

Полілінія, побудована командою pline розглядається в 

AutoCAD, як єдиний об’єкт. Редагування полілінії здійснюється 

командою pedit (ПОЛРЕД). За допомогою команди explode 

(РАСЧЛЕНИТЬ) полілінію можна розбити на окремі об’єкти. А 

фігуру, яку створену командою line можна перетворити в 

полілінію командою pedit. 

 

Порядок виконання роботи 

1. Запустити програму AutoCAD та створити новий файл 

креслення. Створення нового креслення можна розпочати з 

вибору шаблону зі списку, що відкривається командою меню 

File > New (Файл > Создать). Зразок вибраного шаблона 

з’являється праворуч від списку у вікні вибору. 

2. За допомогою графічних примітивів Відрізок, Полілінія 

(використовуючи кнопки на панельному меню або ввівши 

відповідні команди) побудувати лист формату, заданого 

викладачем (Додаток 1) із кутовим штампом визначеного 

розміру. 

3. Використовуючи відповідний стиль тексту з 

стандартизованими шрифтами (див. рис. 1.3), заповнити штамп 

користуючись командою Текст або  Мтекст. 

4. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл для перевірки. 

 

Контрольні запитання. 

1. Як оформлюють креслення? 

2. Що вказується у графах штампу основного напису? 

3. Як зобразити графічний примітив Відрізок? 

4. Як зобразити графічний примітив Полілінія? 

5. Які основні елементи програми AutoCAD ви дізналися? 

6. Опишіть послідовність виконання креслення стандартних 

рамоку програмі AutoCAD?  
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Лабораторна робота №2 

Тема: Розробка двовимірних геометричних моделей у 

середовищі AutoCAD 

Мета: Навчитися розробляти двовимірні графічні об’єкти за 

допомогою геометричних примітивів та глобальних і локальних 

прив’язок. Набути практичні навики двовимірного  

геометричного моделювання. 

 

Теоретичні відомості 

Основні графічні примітиви. Графічний примітив – це 

попередньо визначений основний геометричний елемент, за 

допомогою якого будуються складніші моделі. Прогама 

AutoCAD використовує великий набір примітивів (Рис. 2.1): 

точки, відрізки, кола, дуги, полілінії (неперервна послідовність 

відрізків і дуг), мультилінії (ламана лінія, сегменти якої 

складаються з декількох паралельних відрізків), сплайни (гладкі 

криві, які проходять через заданий набір точок), тексти, блоки 

(іменований об’єкт, сформований із декількох примітивів), 

еліпси, багатокутники, фігури (частина площини, обмежена 

трьома або чотирма відрізками), прості тіла і т. д. Загальні 

властивості, які мають усі примітиви є: належність до шару, 

колір, тип і товщина лінії. Окремі примітиви (текст, блок) мають 

спеціальні властивості: гарнітура, кут нахилу, точка вставки 

тощо. 

Рис. 2.1. Розташування основних графічних примітивів у 

панельному меню у вигляді кнопок 

 

Графічні примітиви Відрізок (Line) та Полілінія (Polyline) та 

способи їх використання детально розглянуті у лабораторній 

роботі 1. Розглянемо інші графічні примітиви, які 

використовуються у програмі AutoCAD. 
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Коло (Circle). Способи введення команди: 

 Набрати з клавіатури команду: _circle (КРУГ). 

 Виклик з меню: Draw > Circle (Рисование > Круг) – 

класичний AutoCAD. 

 Натиснути накнопку на панелі інструментів    . 

Для побудови кола виконайте такі дії: 

 введіть команду одним із вище перерахованих способів; 

 на запит системи Specify center point for circle or [3P/2P/Ttr 

(tan tan radius)] (Центр круга или [3Т/2Т/ККР (кас радиус)]) 

вибрати один із способів побудови кола. 

Коло можна побудувати наступними способами: 

1) вказати координати центра кола і розмір радіуса або 

діаметра; 

 ввести координати центра кола; 

 на запит системи Specify radius of circle or [Diameter] 

(Радиус круга или [Диаметр]) ввести значення радіуса
 

або 

опцію D (Д); 

 якщо ввели опцію D (Д), то з’явиться запит Specify 

diameter of circle  (Диаметр круга), на який потрібно ввести 

значення діаметра. 

2) вказати координати трьох точок, які лежать на колі і не 

належать одній прямій; 

 ввести опцію 3Р (3Т), що відповідає вибору способу 

побудови кола по трьох точках; 

 далі по черзі ввести координати цих точок на відповідні 

запити системи: Specify first point on circle (Первая точка круга); 

Specify second point on circle (Вторая точка круга); Specify third 

point on circle (Третья точка круга). 

3) вказати координати двох точок, які є кінцями діаметра; 

 ввести опцію 2Р (2T), що відповідає вибору способу 

побудови кола по кінцевих точках його діаметра; 

 далі по черзі ввести координати цих точок на відповідні 

запити системи: Specify first end point of circle’s diameter (Первая 

конечная точка диаметра круга); Specify second end point of 

circle’s diameter (Вторая конечная точка диаметра круга). 

4) побудувати коло, яке торкається двох раніше 
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побудованих об’єктів у вказаних точках; 

 ввести опцію Ttr (ККР). В цьому випадку коло стикається 

в двох точках з об’єктами, побудованими раніше; 

 системою буде виданий запит на почергове введення 

координат цих точок: 

Specify point on object for first tangent of circle (Укажите 

точку на объекте, задающую первую касательную); Specify 

point on object for second tangent of circle (Укажите точку на 

объекте, задающую вторую касательную); 

 далі необхідно ввести радіус кола у відповідь на запит 

системи Specify radius of circle (Радиус круга) або натиснути 

клавішу Enter. В цьому випадку радіус буде обчислений 

автоматично. 

Дуга (Arc). Способи введення команди: 

 Набрати з клавіатури команду: _arc (ДУГА); 

 Виклик з меню: Draw > Arc (Рисование > Дуга) – 

класичний AutoCAD; 

 Натиснути кнопку на панелі інструментів     . 

Дуга будується одинадцятьма способами, які розрізняються 

вибором і комбінацією параметрів, відображених у меню: 

Start (Начало) – початкова точка; Center (Центр) – центр 

дуги; End (Конец) – кінцева точка; Angle (Угол) – центральний 

кут; 

Chord Length (Длина) – довжина хорди; 

Direction (Направление) – напрям дотичної (вказується 

однією точкою і збігається з вектором, проведеним в цю точку з 

початкової точки); 

Radius (Радіус) – радіус дуги; 

3 Points (3 Точки) – за трьома точками, що лежать на дузі; 

Continue (Продолжить) – побудова дуги як продовження 

попередньої лінії чи дуги. Початковою точкою і початковим 

напрямом будуть відповідно кінцева точка та кінцевий напрям 

попередніх дуги чи відрізка. При побудові дуги додатним 

вважається напрям побудови дуги проти годинникової стрілки; 

змінити напрям побудови можна, ввівши від’ємне значення 

кута. При будуванні дуги з використанням параметра Довжина 
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змінити напрям побудови можна, ввівши від’ємне значення 

хорди. 

Прямокутник (Rectang). Способи введення команди: 

 Набрати з клавіатури команду: _rectang 

(ПРЯМОУГОЛЬНИК). 

 Виклик з меню: Draw > Rectang (Рисование > 

Прямоугольник) – класичний AutoCAD. 

 Натиснути кнопку на панелі інструментів      . 

Щоб побудувати прямокутник, потрібно вказати координати 

двох діагонально протилежних вершин. Прямокутник можна 

побудувати з заокругленнями (параметр Fillet (Сопряжение), 

необхідно вказати радіус заокруглення) або з фасками (параметр 

Chamfer (Фаска), слід вказати розмір фаски по горизонталі та по 

вертикалі). 

Еліпс (Ellipse). Способи введення команди: 

 Набрати з клавіатури команду: _ellipse (ЭЛЛИПС). 

 Виклик з меню: Draw > Ellipse (Рисование > Эллипс) – 

класичний AutoCAD; 

 Натиснути кнопку на панелі інструментів       . 

Еліпс можна побудувати, вказавши центр та радіус 

ізометричного кола або задавши початкову та кінцеву точку 

однієї осі і відстань від центра еліпса до кінця другої осі, тобто 

комбінацією параметрів, відображених у меню: 

Center (Центр) – центр еліпса. Необхідно також вказати 

координати кінцевої точки осі і відстань від центра до кінцевої 

точки другої осі. 

Axis endpoint (Ось, конец) – кінцева точка осі. При виборі 

даної опції (вона застосовується за замовчуванням) задаються 

дві кінцеві точки першої осі і точка, що вказує відстань від 

центра еліпса до кінця другої осі. 

Arc (Эллиптическая дуга) – дозволяє створити еліптичну 

дугу. Додатковим параметром команди є: 

Rotation (Поворот) – еліпс будується як проекція кола, що 

обертається навколо діаметра, визначеного заданими перед цим 

точками на площину креслення. 

Об’єктна прив’язка. При роботі над кресленнями можна 
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включати і виключати режими, що полегшують виконання 

побудов. Одним з таких режимів є режим об’єктної прив’язки 

(команда _osnap (ПРИВЯЗКА), функціональна клавіша F3), 

який дозволяє зв’язувати точки новостворюваного об’єкта з 

точками раніше створеного. Точками прив’язки можуть бути 

кінцеві або центральні точки об’єктів, точки явного або 

передбачуваного перетину і т. д. Вказівка необхідних точок 

виконується без обчислення їх абсолютних координат. При 

включеному режимі об’єктної прив’язки необхідно вибрати 

спосіб прив’язки і помістити покажчик миші поблизу об’єкта. 

Координати потрібної точки будуть визначені автоматично. 

Об’єктна прив’язка використовується при виконанні 

операцій побудов і редагування у відповідь на запрошення 

програми задати наступну точку. Щоб обрати об’єкти для 

прив’язки, можна скористатися з діалогового вікна (рис.2.2): 

 

 
Рис. 2.2. Вибір об’єктів для прив’язки 

 

Інструменти (параметри) режиму об’єктної прив’язки 

перераховані нижче. Тут великими літерами виділені 

скорочення параметрів, які вводять з клавіатури при роботі з 

командним рядком: 
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 ENDpoint (Конточка) – визначає координати кінцевих 

(крайніх) точок об’єктів (відрізка або дуги); 

 MIDpoint (Середина) – визначає координати точки 

середини відрізка, дуги, полілінії або мультилінії; 

 CENter (Центр) – визначає координати точки центра 

кола, дуги або еліпса; 

 NODe (Узел) – визначає координати точкових об’єктів; 

 QUAdrant (Квадрант) – визначає координати 

квадрантних точок – точок перетину координатних осей з 

колом, дугою або еліпсом; 

 INTersection (Пересечение) – визначає координати точки 

перетину двох ліній, ліній з дугою або колом, двох кіл і/або дуг, 

сплайнів, меж області; 

 EXTension (Продолжение) – визначає координати точки 

на уявному продовженні ліній і дуг; 

 INSertion (Твставки) – визначає координати точки 

вставки тексту, атрибута, форми, визначення атрибута або 

блоку; 

PERpendicular (Нормаль) – визначає координати точки 

на лінії, колі, еліпсі, сплайні або дузі, яка при приєднанні до 

останньої точки створює нормаль до вибраного об’єкта; 

 TANgent (Касательная) – визначає координати точки на 

колі або дузі, яка при з’єднанні з останньою точкою створює 

дотичну до вибраного об’єкта; 

 NEArest (Ближайшая) – визначає координати точки на 

лінії, дузі або колі, яка є найближчою до позиції перехрестя 

графічного курсора; 

 APParent intersection (Кажущееся пересечение) – 

визначає координати точки уявного перетину ліній або меж 

областей; 

 PARallel (Параллельно) – визначає координати точки на 

лінії, яка при з’єднанні з останньою точкою утворює лінію, 

паралельну вибраному відрізку. 

Контролювати правильність вибору режиму прив’язки 
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дозволяє вигляд маркера, що змінюється і невелике віконце, в 

якому вказано спосіб прив’язки (рис. 2.3, а). 

Режим Object Snap Tracking (Об’єктне відстеження) 

використовується спільно з режимом об’єктної прив’язки (Рис. 

2.3, б). Включається натисненням функціональної клавіші F11 

або відповідної кнопки на панелі режимних кнопок. При 

включеному режимі об’єктного відстеження – точному 

позиціонуванню чергової точки допомагають тонкі пунктирні 

лінії, що перетинають об’єкт в точках прив’язки – лінії 

трасування. 

 

а)                                           б) 

Рис. 2.3. Приклад використання об’єктної прив’язки та 

об’єктного відстеження 

 

Цей режим розширює і доповнює можливості об’єктної 

прив’язки, дозволяє задати точне положення об’єктів один 

відносно одного – перпендикулярно, паралельно, поряд, тощо. 

Забезпечується виконання точних геометричних побудов без 

попереднього будування допоміжних ліній. Режим генерує 

будь-яку кількість ліній трасування на основі якого-завгодно 

числа точок і параметрів об’єктної прив’язки. 

Режим відстеження дозволяє також будувати відрізки 

визначеної довжини або задати точно відстань точки, від точки 

об’єктної прив'язки уздовж лінії відстеження. Для цього після 

появи лінії трасування слід показати напрямок, перемістивши 

покажчик «миші» вздовж генерованої лінії, і ввести в 

командному рядку значення необхідної відстані або довжини 

відрізка. 

Для режиму об’єктного відстеження можна задавати 
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генерування лише ортогональних ліній – режим 

ортогонального відстеження ОРТО (функціональна клавіша 

F8) або вмикати режим полярного відстеження ПОЛЯР 

(функціональна клавіша F10) – генерування ліній під кутами, 

кратними стандартним значенням: 90°, 45°, 30°, 22.5°, 18°, 15°, 

10° або 5°. В разі необхідності можна визначити також інші 

значення кутів. Режими ортогонального і полярного 

відстеження не можуть бути активними одночасно. 

 

Порядок виконання роботи 

1. Запустити програму AutoCAD, створити новий файл 

креслення та вибрати варіант завдання згідно з Додатком 2, 

відповідно до порядкового номеру студента у групі.  

2. За допомогою поєднання основних графічних примітивів 

побудувати геометричну фігуру. 

3. Зберегти файл креслення. 

4. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл для перевірки. 

 

Контрольні запитання. 

1. Що таке графічний примітив? 

2. Які способи введення команди Коло (Circle)? 

3. Які способи введення команди Прямокутник (Rectang)? 

4. Які способи введення команди Еліпс (Ellipse)? 

5. Що таке об’єктна прив’язка і як воно реалізується?  

6. Що таке об’єктне відстеження і як воно реалізується? 
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Лабораторна робота № 3 

Тема: Технічне креслення в середовищі графічної системи 

AutoCAD 

Мета: Навчитися виконувати технічні креслення деталей та 

схем в середовищі системи автоматизованого проектування 

AutoCAD.  

 

Теоретичні відомості 

Сучасні технології проектування передбачають використання 

сучасних систем автоматизованого проектування. У цій 

лабораторній роботі розглянуто приклад виконання креслень 

деталей та схем, які складаються з невеликої кількох елементів 

за допомогою програми AutoCAD. Процес виконання креслення 

починається зі встановлення конфігурації деталей та визначення 

їх розмірів. Відповідно до ДСТУ 2.307:2013 «Нанесення 

розмірів і граничних відхилів» та Єдиної системи 

конструкторської документації (ЄСКД) розміри визначаються та 

наносяться за допомогою розмірних ліній та розмірних чисел. 

Лінійні розміри та їх граничні відхилення вказують на 

кресленнях у міліметрах без позначення одиниці, які зазначають 

обов’язково у тексті на полі креслення та в пояснювальній 

записці. Якщо розмір задано не у міліметрах, то одиниці 

вимірювання вказують безпосередньо біля розміру або в 

технічних вимогах. Кутові розміри та граничні відхилення 

зазначають у градусах, хвилинах і секундах з відповідними 

позначками (наприклад 20°10'3"). 

Кожен розмір зазначають лише один раз і на тому зображенні 

де даний елемент показано найбільш зрозуміло. Процес 

нанесення розмірів складається з двох операцій: 

1) проведення виносних і розмірних ліній; 

2) написання розмірного числа. 

Розмірну лінію, що показує межі вимірювання, проводять 

паралельно вимірюваному елементу і закінчують стрілками. 

Форму стрілки, приблизне співвідношення її елементів і 

товщину лінії видимого контуру слід зберігати по всьому 

кресленні (кут – 20°, довжина – 2,5÷3 мм). 

Виносні лінії є допоміжними елементами, їх проводять від 
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меж вимірювання, а між ними проводять розмірні лінії. Виносні 

лінії повинні виходити за кінці стрілок розмірної лінії на 1...5 

мм. Виносні лінії проводять від ліній видимого контуру, 

осьових, центрових і, в разі необхідності, від ліній невидимого 

контуру. Розмірні та виносні лінії виконують тонкими 

суцільними лініями. При нанесенні розміру прямолінійного 

відрізка виносні лінії проводять перпендикулярно до 

вимірюваного елементу (рис. 3.1, а), а при нанесенні розміру 

кута: 

–  радіально (рис. 3.1, б);  

–  паралельно бісектрисі кута (рис. 3.1, в).  

При наявності ухилів та конусностей розмірні і виносні лінії 

проводять так, щоб разом з вимірюваною ділянкою вони 

утворювали паралелограм (рис. 3.1, г). 

а б в г 

Рис. 3.1. Приклади нанесення різних типів виносних і розмірних 

ліній 

 

Якщо довжина розмірної лінії недостатня для нанесення 

стрілок, то їх дозволяється виконувати ззовні вимірюваного 

відрізка. Розмірні лінії рекомендується наносити поза контуром 

зображення. Мінімальна відстань між розмірною лінією та 

лінією контуру має складати 10 мм, між паралельними 

розмірними лініями – 7 мм. Розмірні лінії по можливості не 

повинні перетинатися між собою. Можна проводити розмірні 

лінії безпосередньо до ліній видимого контуру, осьових, 

центрових та інших ліній, проте не допускається їх 

використання як розмірних (рис. 3.2). 

Якщо вигляд чи розріз симетричного предмета зображають 
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лише до осі симетрії або з обривом, то розмірну лінію проводять 

також з обривом трохи далі осі або лінії обриву. 

Розмірні числа проставляють на відстані 1 мм над розмірною 

лінією якомога ближче до її середини. При нанесенні кількох 

паралельних або концентричних розмірних ліній на невеликій 

відстані одна від одної, розмірні числа над ними рекомендується 

розташовувати в шаховому порядку (рис. 3. 3). А якщо місця для 

розмірного числа недостатньо, його проставляють над 

продовженням розмірної лінії або на поличці лінії-виноски. 

 

 
Рис. 3.2. Приклад нанесення 

розмірних ліній від лінії контура  

 
Рис. 3.3. Приклад нанесення 

розмірних ліній з обривом 

 

Орієнтація розмірних чисел здійснюється так, щоб вони 

вільно читалися при нормальному розміщенні креслення або 

при його повороті в межах 90° за годинниковою стрілкою. При 

нанесенні розміру радіуса або діаметра перед розмірним числом 

ставлять відповідно знаки R, Ø (рис. 3.4). 

Рис. 3.4. Варіанти нанесення розмірів радіусів і діаметрів 

 

При нанесенні кутових розмірів їх слід розташовувати у зоні 

вище горизонтальної осьової лінії, а розмірні числа поміщати 

над розмірними лініями з боку опуклості. Якщо необхідно 

вставити розмір у зоні, що знаходиться нижче горизонтальної 
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осьової лінії, то це здійснюється з боку вгнутості розмірних 

ліній. У заштрихованій зоні наносити розмірні лінії не 

рекомендується. Проте, для кутів малих розмірів при нестачі 

місця розмірні числа потрібно поміщати на поличках ліній-

виносок у будь-якій зоні. 

Розміри фасок під кутом 45° наносять у вигляді добутку, 

наприклад, 2×45° (де перше число – висота зрізаного конуса, 

друге – кут нахилу твірної конуса до його осі в градусах), а 

розміри під іншими кутами вказують за загальним правилом – 

двома розмірами: лінійним і кутовим або двома лінійними 

розмірами. 

Розміри, що стосуються одного і того ж конструктивного 

елемента (пазу, отвору тощо), рекомендується групувати і 

розміщувати в одному місці на тому зображенні, де форма 

даного елемента розкривається найповніше. Розміри двох 

симетрично розміщених елементів виробу (крім отворів) 

наносять лише один раз без зазначення їхньої кількості, 

групуючи всі розміри в одному місці (рис. 3.5). 

 
Рис. 3.5. Приклад нанесення розмірів на симетричну деталь 

 

Розмірні числа та граничні відхилення не допускається 

розділяти або перетинати будь-якими лініями креслення. Не 

допускається розривати лінію контуру для нанесення 

розмірного числа та наносити розмірні числа в місцях перетину 

розмірних, осьових і центрових ліній. У місці нанесення 

розмірного числа осьові, центрові лінії та лінії штрихування 
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треба переривати. 

Не допускається наносити розміри у вигляді замкненого 

розмірного ланцюга, тобто сукупності розмірів, що утворюють 

замкнений контур. Не рекомендується проставляти на кресленні 

розміри невидимого контуру, що зображений штриховими 

лініями. 

Похилі паралельні прямі у штрихуванні проводять під кутом 

45° до лінії контуру зображення (рис. 3.6, а) або до його осі (рис. 

3.6, б), чи до лінії рамки кресленика (рис. 3.6, в). Якщо лінії 

штрихування збігаються з лініями контуру чи осьовими лініями, 

рекомендується лінії штрихування проводити під кутом 30° або 

60°. 

 
а                                   б                                в      

Рис. 3.6. Приклади нанесення штрихування 

 

Лінії штрихування можна проводити з нахилом ліворуч або 

праворуч, але для всіх розрізів і перерізів, що належать одній і 

тій самій деталі, штрихування треба виконувати з нахилом в 

один бік. Відстань між прямими лініями штрихування має бути 

однакова для всіх розрізів і перерізів деталі, що виконуються в 

одному масштабі. Залежно від матеріалу площини штрихування 

та необхідності урізноманітнити штрихування суміжних 

площин, відстань між лініями штрихування вибирають у межах 

1 – 10 мм. 

Перерізи, ширина яких становить менше ніж 2 мм, 

допускається зачорнювати, але залишати просвіт між 

суміжними перерізами не менше ніж 0,8 мм. Для суміжних 

перерізів двох деталей слід виконувати зустрічне штрихування: 

на одній деталі праворуч, на іншій – ліворуч. Для суміжних 
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перерізів трьох і більше деталей треба, щоб лінії штрихування 

одного напряму були зсунуті в одному перерізі відносно іншого 

(рис. 3.7, а), або слід змінити відстань між лініями штрихування 

(рис. 3.7, б). 

а                                                         б  

Рис. 3.7. Штрихування суміжних перерізів 

 

Масштабом називається відношення лінійних розмірів 

зображення, поданого на кресленику, до відповідних розмірів 

предмета. Відповідно до вимог діючих стандартів (ДСТУ ISO 

5455:2005, ДСТУ 2.307:2013) для виконання креслеників 

рекомендуються застосовувати масштаби наведені в табл. 3.1. 

 

Таблиця 3.1.  

Рекомендовані масштаби для виконання креслеників 

Масштаби 

зменшення 

1:2; 1:2,5; 1:4; 1:5; 1:10; 1:15; 1:20; 1:25; 1:40; 1:50; 

1:75; 1:100; 1:200; 1:400; 1:500; 1:800; 1:1000 

Натуральна 

величина 
1:1 

Масштаби 

збільшення 
2:1; 2,5:1; 4:1; 5:1; 10:1; 20:1; 40:1; 50:1; 100:1 

 

Масштаб заноситься у вигляді 1:2; 2:1 і т.д. у відповідну 

графу основного напису. Масштаб зображення, що відрізняється 

від зазначеного в основному написі кресленика, вказують 

безпосередньо над написом, що відноситься до даного 

зображення: А/М 2:1; 1/М 10:1 тощо. Незалежно від масштабу 
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на зображення завжди наносять справжні розміри виконаного 

елементу. 

Нанесення розмірів в AutoCAD. Розміри повинні повністю 

визначати величину виробу, а їх кількість повинна бути 

достатньою для розуміння креслення. Нанесення розмірів у 

AutoCAD можна виконати одним із двох методів. Перший 

полягає у тому, що після введення команди курсором мишки 

вказується об’єкт, розмір якого вимірюється і задається 

положення розмірної лінії. При використанні другого методу 

курсором миші вказуються початкові точки виносних ліній і 

положення розмірної лінії. В останньому випадку 

рекомендується включити режим об’єктної прив’язки. 

Варіанти нанесення розмірів або їх редагування містяться у 

команді меню Dimensions (Размеры) для класичного AutoCAD, а 

також у вигляді кнопок на панелі Annotate > Dimensions
  

(Аннотации > Размеры) режиму Drawing & Annotation
 

(Рисование и аннотации): Annotate > Dimensions (Аннотации > 

Размеры) (Рис. 3.8). AutoCAD дає змогу створювати асоціативні 

розміри, які при зміні об’єктів командами редагування 

автоматично оновлюються. 

Рис. 3.8. Елементи розмірів у панельній стрічці-підменю 

 

Вигляд розміру на кресленні залежить від вибраного стилю. 

За умовчанням пропонується стиль ISO-25, який призначений 

для машинобудівельного креслення. AutoCAD надає можливість 

вносити зміни в існуючі стилі, а також створювати власні стилі. 

Від вибраного розмірного стилю залежить відображення 

виносних ліній, розмір і положення тексту, довжина і тип 

стрілок, базовий інтервал між розмірними лініями та ін. 

Керують процесом нанесення розмірів розмірні змінні, значення 

яких можна змінити відповідними командами або у діалоговому 

вікні Dimension Style Manager (Диспетчер размерных стилей) 
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(рис. 3.9), створивши новий стиль або редагуючи існуючий. 
 

 
Рис. 3.9. Діалогове вікно розмірних стилів Dimension Style 

Manager (Диспетчер размерных стилей)  

 

Внесення змін в існуючий стиль відбувається у діалоговому 

вікні Modyfy Dimension Style (Изменение размерного стиля) (рис. 

3.10). На відповідних вкладках даного вікна можна змінити 

значення розмірних змінних. Існуючий стиль редагується за 

допомогою кнопки Modyfy (Редактирование). Для створення 

нового стилю необхідно натиснути кнопку New (Новый), після 

чого можна задати характеристики розмірів. 
 

 
Рис. 3.10. Внесення змін у розмірний стиль у діалоговому вікні 

Modyfy Dimension Style (Изменение размерного стиля)  

На вкладці Lines (Линии) задається колір, товщина та інші 
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характеристики розмірних та виносних ліній. На вкладці 

Symbols and Arrows (Символы и стрелки) вибирається тип та 

розмір стрілок. На вкладці Text (Текст) вибираються параметри 

розмірного тексту: колір, стиль, вирівнювання. На вкладці Fit 

(Размещение) здійснюється управління взаємним розміщенням 

розмірних, виносних ліній та тексту, а також масштабом 

розмірів. На вкладках Primary Units (Основные единицы) та 

Alternate Units (Альт. Единицы) визначається формат одиниць 

вимірювання, задається точність. На вкладці Tolerance (Допуски) 

визначається формат та точність допусків. 

Команди для нанесення розмірів у AutoCAD. 

1. Лінійний розмір. Способи введення команди: 

 Набрати з клавіатури команду: _dimlinear 

(РЗМЛИНЕЙНЫЙ). 

 Виклик з меню: Dimension > Linear (Размеры > Линейный) 

– класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Лінійні розміри можуть бути горизонтальними, 

вертикальними, ординатними, утворювати розмірні ланцюги або 

можуть бути нанесені від загальної бази. Найпростіше 

проставити розмір за наступним методом: 

1) включити режим об’єктної прив’язки; 

2) графічним курсором показати першу початкову точку 

виносної лінії; 

3) на запит Specify second extension line origin (Начало второй 

выносной линии) показати другу початкову точку виносної лінії; 

4) задати положення розмірної лінії на запит Specify 

dimension line location or [Mtext/ Text/ Angle/ Horizontal/ Vertical/ 

Rotated] (Положение размерной линии или [Мтекст/ Текст/ 

Угол/ Горизонтальный/Вертикальный/Повернутый]) або ввести 

одну із запропонованих системою опцій: 

Mtext (Мтекст) – відкриється вікно багаторядкового 

текстового редактора Multiline Text Editor, в якому можна внести 

зміни в розмірний текст. Кутові дужки <…> позначають 
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розмірне число визначене системою за замовчуванням. 

Text (Текст) – дозволяє внести зміни в розмірний текст, 

скориставшись редактором однострічкового тексту. 

Angle (Угол) – дозволяє змінити кут нахилу розмірного числа 

або розмірного тексту. 

Horizontal (Горизонтальный) – використовується для 

нанесення горизонтального розміру. 

Vertical (Вертикальный) – використовується для нанесення 

вертикального розміру. 

Rotated (Повернутый) – використовується, якщо необхідно 

задати кут нахилу розмірної лінії. 

2. Паралельний розмір. Способи введення команди: 

 Набрати з клавіатури команду: _dimaligned (РЗМПАРАЛ). 

 Виклик з меню: Dimension > Aligned (Размеры > 

Параллельный) – класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Даною командою будується розмірна лінія, кут нахилу якої 

збігається з кутом нахилу вибраного об’єкта. Розмір наноситься 

аналогічно лінійному. 

3. Базовий розмір. Способи введення команди: 

 Набрати з клавіатури команду: _dimbaseline 

(РЗМБАЗОВЫЙ). 

 Виклик з меню: Dimension > Baseline (Размеры > Базовый) 

– класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
За базову приймається перша виносна лінія розміру, 

проставленого попередньою командою, або також можна 

вибрати іншу базову лінію. Запит, щодо положення розмірної 

лінії не видається, оскільки базовий інтервал визначається 

розмірним стилем. Виконується команда в тому випадку, коли 

на креслення нанесений хоча б один розмір, будь-якою з команд 

DIMLINEAR, DIMORDINATE або DIMANGULAR. 
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4. Розмірний «ланцюг». Способи введення команди: 

 Набрати з клавіатури команду: _dimcontinue (РЗМЦЕПЬ). 

 Виклик з меню: Dimension > Continue (Размеры > Цепь) – 

класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Команда створює розмірний ланцюжок, в якому друга 

виносна лінія попереднього розміру є початковою для розміру, 

що проставляється. Розмірні лінії належать одній прямій і 

запити щодо їх положення не видаються. Робота команди 

аналогічна роботі попередньої команди DIMBASELINE. 

5. Ординатний розмір. Способи введення команди: 

 Набрати з клавіатури команду: _dimordinate 

(РЗМОРДИНАТА). 

 Виклик з меню: Dimension > Ordinate (Размеры > 

Ординатный) – класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Ординатні розміри вказують координати X або Y точок 

відносно базової точки. Базовою точкою, як правило, є лівий 

нижній кут деталі. Центр системи координат перед 

простановкою ординатних розмірів можна перемістити у базову 

точку командою налаштування початку системи координат UCS 

(ПСК) з опцією New (Начало). Ординатний розмір задає 

відстань точки до базової точки відповідно вздовж осі Х або 

вздовж осі Y і складається з виносної лінії і значення відстані. 

Вздовж якої осі проставити значення відстані, система визначає 

автоматично. 

6. Діаметр. Способи введення команди: 

 Набрати з клавіатури команду: _dimdiameter 

(РЗМДИАМЕТР). 

 Виклик з меню: Dimension > Diameter (Размеры > 

Диаметр) – класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 
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(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Розмір дуги або кола визначається значенням радіуса або 

діаметра. Для цих об’єктів існує також можливість нанесення 

маркерів центра і центрових ліній. Після введення команди на 

запит Select arc or circle (Выберите дугу или круг) показати 

перехрестям будь-яку точку об’єкта. AutoCAD дозволяє 

створити розмірну лінію довільної довжини і розмістити її під 

будь-яким кутом. Користуючись опціями команди, можна 

редагувати розмірний текст, а також змінити кут нахилу. Перед 

значенням діаметра AutoCAD автоматично вставляє символ Ø. 

Для позначення діаметру розмірна лінія не повинна бути 

вертикальною або горизонтальною. 

7. Радіус. Способи введення команди: 

 Набрати з клавіатури команду: _dimradius (РЗМРАДИУС). 

 Виклик з меню: Dimension > Radius (Размеры > Радиус) – 

класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Нанесення радіуса здійснюється аналогічно до нанесення 

діаметра. Перед значенням радіуса AutoCAD автоматично 

вставляє символ R. 

8. Кутовий розмір. Способи введення команди: 

 Набрати з клавіатури команду: _dimangular 

(РЗМУГЛОВОЙ). 

 Виклик з меню: Dimension > Angular (Размеры > Угловой) 

– класичний AutoCAD. 

 Натиснути кнопку на панелі Annotate > Dimensions 

(Аннотации > Размеры) режиму Drawing & Annotation 

(Рисование и аннотации) . 
Кутові розміри можна визначити для дуги, двох відрізків, 

трьох точок, що не належать прямій. Виводяться кутові розміри 

з позначенням одиниці вимірювання – ˚(градус). Розмірною 

лінією кутового розміру є дуга з центром у вершині кута, 

виносні лінії формуються автоматично. Кутові розміри можна 
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наносити від загальної бази, а також створювати розмірний 

ланцюг. 

Штрихування об’єктів в AutoCAD. Для умовного 

графічного зображення матеріалів у розрізах і перерізах 

застосовують різноманітні штрихування. У технічних 

кресленнях штрихування застосовують для позначення типу 

конструкційного матеріалу. 

Штрихування – множина ліній, які утворюють певний 

малюнок, воно вставляється, як єдиний об’єкт для замкнутих 

областей. У програмі AutoCAD передбачено декілька типів 

штрихувань, які створюється на основі узорів з ліній, які 

повторюються за допомогою вбудованої бібліотеки стандартних 

зразків штрихування. 

Штрихування в програмі AutoCAD характеризуються такими 

властивостями: 

1) штрихування у вигляді блоків – всі лінії, які знаходяться 

всередині позначеної області, є частиною єдиного об’єкта; 

2) асоціативне штрихування – при зміні розміру об’єкта 

використане в ньому штрихування автоматично оновиться і 

прийме нову форму. 

Способи введення команди штрихування: 

 Набрати з клавіатури команду: _bhatch (КШТРИХ). 

 Виклик з меню: Draw > Hatch (Рисование > Штриховка) – 

класичний AutoCAD. 

 Натиснути кнопку на панелі Home > Modify (Главная > 

Редактирование) режиму Drawing & Annotation (Рисование и 

аннотации) . 

Команда _bhatch (КШТРИХ) відкриває на панелі меню 

вкладку Hatch Creation (Создание штриховки) з вкладками 

Boundaries (Контуры), Pattern (Образец), Properties (Свойства), 

Origin (Начало), Options (Параметры), Close (Закрыть) (рис. 

3.11). На вкладці Pattern (Образец) вибирається штрихування за 

іменем зі списку або за малюнком – зразки малюнків 

представлені у вікні. У Properties (Свойства) можна задати кут 

нахилу і масштаб штрихування. Після вибору зразка і 

параметрів штрихування необхідно показати об’єкти, які будуть 

заштриховані. 
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Рис. 3.11. Вигляд вкладки Hatch Creation (Создание штриховки) 

на панельному підменю  

 

Для вибору об’єктів штрихування пропонується декілька 

способів. Можна безпосередньо вибирати об’єкт або вказати 

точку всередині замкнутого контуру, надаючи можливість 

системі автоматично визначити область, яка підлягає 

штрихуванню – вкладка Boundaries (Контуры). Для виконання 

вибору використовується відповідна кнопка, яка зкеровує у 

вікно креслення, де почергово вибирається кожен об’єкт або 

вказуються точки всередині замкнутих контурів. Після вибору 

необхідно повернутися в діалогове вікно штрихування 

(натиснувши клавішу Enter). 

Для вибору асоціативного або аннотативного штрихування 

переходять на вкладку Options (Параметры). Асоціативність 

означає, що штрихування прив’язується до контурів об’єкта та 

при зміні їх форми автоматично змінюється область, яка 

заповнена штрихуванням. Аннотативність передбачає 

автоматичне масштабування штрихування разом з об’єктом при 

масштабуванні. А команда _hatch (ШТРИХ) створює 

неасоціативне штрихування. Функцію асоціативності можна 

увімкнути/вимкнути на вкладці Options (Параметры). 

Види та розміщення їх на креслениках. Методи побудови і 

читання креслеників ґрунтуються на засадах нарисної геометрії. 

Зображення предметів виконують за методом прямокутного 

проектування. При цьому припускають, що зображенні 

предмета чи його складової частини знаходиться між 

спостерігачем і відповідною площиною проекцій. Згідно вимог 

діючих стандартів кресленик повинен давати повну уяву про 

зовнішню та внутрішню форму предмета, його розміри та 

конструктивні особливості. Зображення на креслениках залежно 

від їх змісту поділяють на види, розрізи, перетини. Кількість 

видів, розрізів і перетинів повинна бути найменшою, але 
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достатньою для повного уявлення про зображуваний предмет. 

Деякі прості тіла обертання (вали, втулки та ін.) можна 

зображувати в одній проекції, якщо на ній нанести розміри і 

позначення, що відображають їх форму Для зображення більш 

складних фігур необхідно три і більше проекцій . 

Видом називається зображення видимої частини поверхні 

предмета зверненої до спостерігача. Шість основних видів 

стандартного розташування проекцій – це розгорнуті грані 

паралелепіпеда, у середині якого розміщують проектований 

предмет (рис. 3.12). 

Рис. 3.12. Види стандартного розташування проекцій 

 

Найчастіше використовують три основних види: 1) вид 

спереду; 2) вид зверху; 3) вид зліва. При необхідності можна 

використовувати додаткові види.  

Усі види зберігають на креслениках проекційний зв’язок. 

Якщо треба показати поверхню предмета, яка не паралельна ні 

одній із площин проекцій та потребує пояснень, 

використовують місцевий вид. На місцевому виді вказують 

стрілкою напрямок проектування та позначають його літерою, а 

в окремому вільному місці надають вказаний вид з тією ж 

літерою. 
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Переріз (перетин) – це зображення, що утворюється при 

уявному розсіченні предмета площиною (або декількома 

площинами). Щоб одержати переріз, 3D-модель розсікають 

уявною січною площиною в тому місці, де потрібно виявити її 

форму. На перерізі зображується тільки те, що безпосередньо 

знаходиться в січній площині (рис. 3.13). А все, що знаходиться 

поза січною площиною - не зображується. 

Рис. 3.13. Приклади виконання перерізів 

 

Місце розташування січної площини позначається 

потовщеною розімкнутою лінією з великими літерами і 

стрілками, що показують напрямок погляду. Такими ж самими 

літерами позначають отриманий переріз. Для наочності на 

кресленику переріз виділяють штрихуванням. Залежно від 

розташування перерізи поділяються на накладені та винесені. 

Якщо на одній деталі роблять декілька однакових перерізів, то 

їх позначають однією тією ж літерою і викреслюють лише один 

переріз. 

Розрізом називається зображення предмета, уявно 

розсіченого однією або декількома площинами. На розрізі 

показують те, що знаходиться в січній площині, і те, що 
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розташовано за нею. Ближчу відсічену частину уявно 

відкидають. Розрізи бувають прості, складні та місцеві. 

Простий розріз – це розріз, який зроблено за допомогою 

однієї січної площини (рис. 3.14). Залежно від положення січної 

площини розрізи поділяються на вертикальні і горизонтальні. 

Рис. 3.14. Приклад вертикального профільного розрізу  

 

Якщо січна площина паралельна фронтальній площині 

проекцій, вертикальний розріз називають фронтальним. Коли 

січна площина паралельна профільній площині проекцій, 

вертикальний розріз називають профільним. У випадку, коли 

січна площина горизонтальна, розріз називають 

горизонтальним. На одному кресленику може бути декілька 

розрізів, але кожен з них повинен бути доцільним. Розрізи 

звичайно розташовують: фронтальний – на місці головного 

виду, профільний – на місці виду зліва, а горизонтальний - на 

місці виду зверху. Розрізи позначають так само, як перетини, 

розімкнутою лінією. Стрілки з літерами показують напрямок 

погляду.  

Місцевим називають розріз, який служить для з’ясування 

форми предмета, в окремому місці деталі, наприклад, отвору. 

Коли робити повний розріз недоцільно місце розрізу виділяють 

на зображені суцільною тонкою хвилястою лінією. Складним 

вважається розріз, який має дві і більше січні площини. Якщо ці 

площини паралельні, то розріз називається східчастим. Розріз 

виконується так, начебто зроблений однією площиною без будь 

яких ліній у місці сходинки (штрихування на фронтальній 

проекції без переходів). Січні площини позначені потовщеною 
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розімкнутою лінією перетину з літерами і стрілками з 

потовщеними штрихами в місцях перегинів де показують кінець 

однієї і початок іншої січної площини (літери у перегинах не 

ставлять). Складний розріз позначається великими літерами. 

 

Порядок виконання роботи 

1. Розглянути способи виконання технічних креслень деталей 

та схем у програмі AutoCAD з теоретичних відомостей.  

2. Вибрати деталь згідно варіанту з Додатку 3. 

3. За допомогою поєднання основних графічних примітивів 

Відрізок, Полілінія, Коло, Прямокутник тощо (використовуючи 

кнопки на панельному меню або введення відповідних команд), 

а також команд редагування за двома проекціями деталі 

побудувати третю. 

4. Виконати необхідні розрізи та нанести розміри. Креслення 

виконується в режимі 2-D на аркуші формату А3 (лист 

розташовується горизонтально).  

5. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл для перевірки. 

 

Контрольні запитання. 

1. Як наносять розміри на кресленнях? 

2. Як наносять розмірні числа на кресленнях? 

3. Як наносять штрихування на кресленнях? 

4. Які види стандартного розташування проекцій? 

5. Як виконується штрихування об’єктів в AutoCAD? 

6. Як виконується виконання перерізів в AutoCAD? 
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Лабораторна робота №4 

Тема: Розробка 3D-моделей при проектуванні елементів 

електричних систем 

Мета: Навчитися виконувати 3D-моделі елементів 

електричних систем використовуючи програму AutoCAD. 

 

Теоретичні відомості 

Сучасне виробництво неможливе без промислового 

моделювання об’єктів. 3D-технології дають можливість значної 

економії матеріалів і зменшення фінансових витрат на 

інженерне проектування. За допомогою 3D-моделювання 

можливо відразу створювати тривимірні зображення деталей і 

об'єктів, які в подальшому можна використовувати для 

створення зборок констукції, вузлів та механізмів, прес-форм та 

прототипів проектованих об’єктів ще до початку їх 

виготовлення. 

До прийомів 3D-моделювання відносять способи формування 

тривимірного графічного об’єкту – розрахунок його параметрів, 

креслення основи або об’ємної, форми; витискання, 

нарощування, вирізання деталей і т. п. До інструментів 3D-

моделювання належать комп’ютерні програми такі, як 

AutoCAD, SolidWorks, 3D-MAX та ін., а також інші програми 

для об’ємної візуалізації предметів у просторі. 

Способи побудови 3D-об’єктів у програмі AutoCAD. 

Площина екрану програмного середовища AutoCAD збігається з 

площиною XY світової системи координат вона називається 

площиною побудов. Будуючи двовимірні об’єкти, можна 

змінювати їх рівень, тобто керувати переміщенням площини 

побудов вздовж осі Z. Спостерігати за зміною рівня площини 

можна при переході до ізометричних видів. Змінити рівень 

площини побудови можна введенням додатного або від’ємного 

числа у поле Elevation (Уровень). Увівши значення 100, 

отримаємо зсув об’єкта вгору вздовж осі Z, від’ємне значення у 

полі призведе до зміщення об’єкта вниз вздовж осі Z.  

Один із найпростіших способів створення тривимірних 

об’єктів це – витискання. Витисканням називається зміна 

властивості двовимірного об’єкта (товщина або висота). 
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Виконати операцію можна, вибравши із контекстного меню 

об’єкта команду Properties (Свойства) і змінивши значення у 

полі Thickness (Высота 3D). 

Вводити можна як додатне так і від’ємне значення. У 

першому випадку об’єкти видтискаються вздовж додатного 

напрямку осі Z, в другому вздовж від’ємного (рис. 4.1). На 

криволінійній частині об’єктів система виводить деяку кількість 

твірних ліній. 

 

 
Рис. 4.1. Побудова 3D-об’єкта «Выдавливанием» 

 

До об’єктів утворених таким способом можна застосувати 

команду _hide (Скрыть), щоб приховати невидимі лінії. 

Витискання полілінії прямокутника створює об’єкти з 

«непрозорими» боковими стінками. 

Тривимірні об’єкти в AutoCAD можна представити 

каркасами, поверхнями і твердотілими моделями. Каркасні 

моделі представлені лише ребрами граней являють собою 

прозорі об’єкти. Створюється каркасна модель командами 

побудови двовимірних графічних примітивів, до яких належать 

відрізки, точки, кола, дуги тощо, але при цьому задавати 

потрібно тривимірні координати точок X, Y, Z. 

Поверхні мають непрозорі грані але порожні всередині, 

представлені оболонкою без наповнення. Такі поверхні можуть 

представлятися не лише ребрами, вони мають також непрозорі 

грані. Крім того, поверхня може бути представлена сіткою, 
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тобто низкою послідовно розташованих граней, що мають 

спільні ребра. 

Твердотільний об’єкт – суцільний, має об’єм і масу. За 

допомогою відповідних команд у AutoCAD можна створити 

поверхні таких типів: 

1. 3DFACE (3DГРАНЬ) будує тривимірну грань, яка 

задається трьома або чотирма ребрами. 

2. 3DMESH (3DСЕТЬ) будує сітку з чотирикутників, 

вершини яких потрібно задати. 

3. PFACE (ПГРАНЬ) будує багатогранну сітку, для якої 

задаються вершини і вказуються грані до яких вони належать. 

4. EDGESURF (П-КРОМКА) будує поверхню Кунса, 

обмежену чотирма криволінійними або прямими ребрами. 

5. RULESURF (П-СОЕД) утворює сітку, що з’єднує два 

криволінійні або прямі ребра. 

6. REVSURF (П-ВРАЩ) утворює поверхню обертання 

шляхом обертання двовимірного об’єкта навколо осі. 

7. TABSURF (П-СДВИГ) утворює поверхню шляхом 

переміщення двовимірного об’єкта в заданому напрямку. 

Тривимірна грань (3DMesh). Способи введення команди: 

- набрати з клавіатури команду _3dmesh (3DСЕТЬ); 

- натиснути кнопку  на панелі інструментів (відсутня у 

інтерфейсі панелей інструментів за замовчуванням, 

налаштовується через пункт Customize (Адаптация)). 

Команда 3DMESH (3DСЕТЬ) будує довільну незамкнену сітку з 

чотирикутників, вершини яких потрібно задати. Використання 

команди дозволяє побудувати сітку складної конфігурації. 

Команда видає запит на розмір сітки в напрямках М (Enter size 

of mesh in M direction (Размер сети в направлении M)), який 

ближче до горизонтального  напрямку (вісь Х у XY-площині) і 

N (Enter size of mesh in N direction (Размер сети в направлении 

N)), який ближче до вертикального напрямку (вісь Y у XY-

площині). У відповідь потрібно ввести число в діапазоні від 2 до 

256. Далі видаються запити щодо координат точок (вершин). 

Приклад побудови сітки з М = 4, N = 3 показано на рис. 4.2. 
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Рис. 4.2. Приклад побудови сітки командою _3DMESH 

(3DСЕТЬ) 

 

Поверхня переміщення (Tabsurf). Способи введення команди: 

- набрати з клавіатури команду: _tabsurf (П-СДВИГ); 

- викликати з меню: Draw>Modeling>Meshes> Tabulated 

Mesh (Рисование > Моделирование > Сети > Сеть сдвига) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Mesh > 

Primitives (Сеть > Примитивы). 
Команда TABSURF утворює поверхню шляхом переміщення 

двовимірного об’єкта в заданому напрямку. Об’єкт 

переміщення задається відрізком, дугою, поліллінією. Напрямок 

переміщення задається відрізком або незамкненою полілінією. 

Вектором, що задає напрям і відстань зсуву може бути відрізок 

або розімкненена полілінія (2D, 3D). Створена сітка є набором 

многокутників з паралельними направляючому вектору 

сторонами. І визначальна крива і вектор повинні існувати на 

рисунку до моменту виклику команди (рис. 4.3). 

Поверхня обертання (Revsurf). Способи введення команди: 

- набрати з клавіатури команду: _revsurf (П-ВРАЩ); 

- викликати з меню: Draw>Modeling>Meshes> Revolved Mesh 

(Рисование > Моделирование > Сети > Сеть вращения) – 

класичний AutoCAD; 
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- натиснути кнопку  на панелі інструментів Mesh > 

Primitives (Сеть > Примитивы). Поверхня утворюється 

обертанням вибраного об’єкта навколо заданої осі. 

 

Рис. 4.3. Приклад побудови 3D-сітки командою _TABSURF (П-

СДВИГ) 

 

Об’єктом обертання можуть бути відрізок, дуга, полілінія 

тощо. Вісь задається відрізком або кінцевими точками 

незамкненої полілінії. Об’єкт можна повернути на повний кут 

360˚ або на заданий кут. Крім того, можна вибрати початкове 

значення кута і задати значення кута повороту. Додатне 

значення кута задається проти годинникової стрілки. Розмір 

сітки поверхонь обертання визначається значенням системних 

змінних SURFTAB1 і SURFTAB2. 

Побудова 3D-тіл. 3D-тіла можна будувати на базі 

елементарних форм: паралелепіпедів, конусів, циліндрів, сфер, 

торів і клинів, а також шляхом витиснення 2D-об’єктів або 

обертання їх довкола осі. Складні просторові тіла створюються 

шляхом комбінування елементарних. Елементарні форми можна 

об'єднувати, віднімати і перетинати (тобто брати тільки спільну 

займану декількома тілами частину об'єму). 

Подальша модифікація тіл здійснюється шляхом спряження 

їх граней і зняття фасок. Підтримується ряд функцій, пов’язаних 

з редагуванням граней тіл, що не потребує побудови додаткових 

геометричних об’єктів і виконання логічних операцій. В 
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AutoCAD також є команди, за допомогою яких тіло можна 

розрізати на дві частини або здійснити розріз площиною. 

Густина ліній кривизни, що використовуються для 

візуалізації криволінійних елементів моделі, визначається 

системною змінною ISOLINES. Системна змінна FACETRES 

задає ступінь згладжування тонованих об’єктів з усуненими 

невидимими лініями. 

Паралелепіпед (Box). Способи введення команди: 

- набрати з клавіатури команду: _box (ЯЩИК); 

- викликати з меню: Draw > Solids > Box (Рисование > 

Моделирование > Ящик) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Box (Фигура > Примитив > Ящик).  

Паралелепіпед визначається точками кутів основи 

паралелепіпеда і висотою або центром, висотою і трьома 

розмірами – довжиною, шириною, висотою. Основа 

паралелепіпеда завжди паралельна площині XY поточної UCS 

(ПСК). 

Конус (Cone). Способи введення команди: 

- набрати з клавіатури команду: _cone (КОНУС); 

- викликати з меню: Draw > Modeling > Cone (Рисование > 

Моделирование > Конус) – класичний AutoCAD; 

- натиснути на кнопку  панелі інструментів Solid > 

Primitive > Polysolid > Cone (Фигура > Примитив > Политело > 

Конус). 
Конус будується з еліптичною або круговою основою і 

визначається положенням центра, радіусом основи і висотою. За 

умовчанням основа конуса розташовується в площині XY 

поточної UCS (ПСК). Висота конуса (може бути як додатною, 

так і від’ємною) паралельна до осі Z. Положення вершини 

конуса визначає його висоту і орієнтацію. За замовчуванням 

висота перпендикулярна основі. Змінити орієнтацію конуса 

можна, якщо вибрати опцію Axis endpoint (Конечная точка оси) 

і задати координати вершини конуса. 

Для побудови зрізаного конуса, або конуса орієнтованого під 

певним кутом потрібно скористатись опцією Top radius (Радиус 
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верхнего основания) або спочатку намалювати круг, а потім 

командою видавлювання виконати витиснення зі звуженням під 

кутом до осі Z. 

Піраміда (Pyramid). Способи введення команди: 

- набрати з клавіатури команду _pyramid (ПИРАМИДА); 

- викликати з меню: Draw > Modeling > Pyramid (Рисование 

> Моделирование > Пирамида) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Pyramid (Фигура > Примитив > 

Политело > Пирамида). 
За замовчуванням піраміда визначається за центром базової 

точки, точкою посередині кромки і точкою, яка задає висоту. 

Циліндр (Cylinder). Способи введення команди: 

- набрати з клавіатури команду: _cylinder (ЦИЛИНДР); 

- викликати з меню: Draw > Modeling > Cylinder (Рисование 

> Моделирование > Цилиндр) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Cylinder (Фигура > Примитив > Цилиндр). 

Основа циліндра може бути круговою або еліптичною, 

розташовується в площині XY поточної UCS (ПСК). Для 

побудови циліндра необхідно визначити положення центра 

основи, радіус або діаметр основи. Висота циліндра задається 

введенням конкретного значення. 

Сфера (Sphere). Способи введення команди: 

- набрати з клавіатури команду: _sphere (СФЕРА); 

- викликати з меню: Draw > Modeling > Sphere (Рисование > 

Моделирование > Сфера) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Sphere (Фигура > Примитив > Сфера). 

Сфера будується після визначення положення центра і 

радіуса. Основа кулі розташовується в площині XY поточної 

UCS (ПСК). 

Тор (Torus). Способи введення команди: 

- набрати з клавіатури команду: _torus (ТОР); 

- викликати з меню: Draw > Modeling > Torus (Рисование > 
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Моделирование > Тор) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Torus (Фигура > Примитив > Политело 

> Тор). 
Твердотілий тор має центр на початку координат і вісь 

паралельну осі Z. Площина XY поточної UCS (ПСК) ділить тор 

на дві рівні частини в подовжньому перетині. Тор будується 

після визначення положення центра, радіуса кола, що проходить 

через центр труби і радіуса труби. 

Клин (Wedge). Способи введення команди: 

- набрати з клавіатури команду: _wedge (КЛИН); 

- викликати з меню: Draw > Modeling > Wedge (Рисование > 

Моделирование > Клин) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Wedge (Фигура > Примитив > Политело 

> Клин). 
Основа клину паралельна площині XY поточної UCS (ПСК), а 

похила грань розташовується напроти першого вказаного кута 

основи. Висота клина (може бути як додатною, так і від’ємною) 

паралельна до осі Z. Ребро похилої грані орієнтоване вздовж осі 

Х. Для побудови клину потрібно задати координати двох 

протилежних вершин основи і висоту. Вибір опції Length 

(Длина) дозволить задати три розміри: Length – довжину вздовж 

осі Y, Width – ширину вздовж осі Х, Height – висоту вздовж осі 

Z. Опція CEnter призначена, щоб задати центр клину. Центром 

клину є центр похилої грані. 

Створення 3D-тіл з двовимірних об’єктів. 3D-тіла можна 

створювати шляхом витиснення двовимірних об’єктів (тобто 

надання їм висоти) за допомогою команди EXTRUDE 

(ВЫДАВИТЬ). Витиснення можна застосовувати до таких 

замкнутих кривих, як полілінії, многокутники, прямокутники, 

кола, еліпси, замкнуті сплайни, кільця і області. Неможливо 

витиснути: тривимірні об’єкти, що входять в блоки, розімкнені 

полілінії і полілінії з сегментами, що перетинаються. Напрям 

витиснення визначається траєкторією або заданням глибини і 

кута. 



46 

 

Витискання (Extrude). Способи введення команди: 

- набрати з клавіатури команду: _extrude (ВЫДАВИТЬ); 

- викликати з меню: Draw > Modeling > Extrude (Рисование 

> Моделирование > Выдавить) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Solid > Extrude (Фигура > Фигура > Выдавить). 

Витискання здійснюється перпендикулярно до площини 

об’єкта або вздовж заздалегідь заданої траєкторії. Можна 

задавати кут конусності, під яким сторони тіла будуть 

звужуватись. Від’ємне значення кута призводить до розширення 

сторін. 

Об’єкт, що витискається може бути областю, колом, 

прямокутником кільцем, замкненою полілінією. Траєкторія 

вздовж якої витискається об’єкт, повинна належати одній 

площині і може бути відрізком, полілінією, дугою. Але об’єкт і 

траєкторія не повинні належати одній площині. 

Команда EXTRUDE (ВЫДАВИТЬ) часто використовується 

для отримання моделей складних об’єктів такі, як шестерні або 

зірочки. Особливо зручна ця команда для об’єктів, що мають 

спряження, фаски і аналогічні елементи, які важко відтворити 

без використання витиснення перетинів. 

Обертання (Revolve). Способи введення команди: 

- набрати з клавіатури команду: _revolve (ВРАЩАТЬ); 

- викликати з меню: Draw > Modeling > Revolve (Рисование > 

Моделирование > Вращать) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Solid > Revolve (Фигура > Фигура > Вращать). 

Тривимірний об’єкт утворюється з двовимірного обертанням 

навколо заданої осі. Двовимірний об’єкт може бути областю, 

колом, еліпсом багатокутником, замкненою полілінією або 

замкненим сплайном. Неможливо застосувати обертання до: 

тривимірних об’єктів; які входять в блоки; розімкнутих 

поліліній і поліліній з сегментами, що перетинаються. 

Тіла можна створювати шляхом обертання замкнутих 

об’єктів на заданий кут довкола осі X або Y поточної UCS 

(ПСК). Крім того, об’єкт можна обертати довкола відрізка, 
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полілінії або двох заданих точок. Подібно до команди 

EXTRUDE, цю команду зручно застосовувати для об’єктів, що 

мають спряження і інші аналогічні елементи. 

Вісь обертання вказується одним із методів: 

- Specify start point for axis of revolution (Начальная точка оси 

вращения) – задаються координати двох точок, початкової і 

кінцевої, що належать осі; 

- Опція Object (Объект) – вибирається відрізок або фрагмент 

полілінії; 

- Опція X/Y/Z: – віссю вибирається додатний напрям осі Х, Y 

або Z поточної системи координат. 

Після визначення об’єкта обертання і осі вводиться довільне 

значення кута повороту об’єкта. 

Побудова складних 3D-тіл. AutoCAD дозволяє будувати 

3D-тіла складної форми, застосовуючи об’єднання, віднімання і 

перетин вже побудованих тіл. 

Об’єднання (Union). Способи введення команди: 

- набрати з клавіатури команду: _union (ОБЪЕДИНЕНИЕ); 

- викликати з меню: Modify > Solid editing > Union 

(Редактировать > Редактирование тела > Объединение) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Solid > 

Boolean > Union (Фигура > Логические операции > 

Объединение). 
За допомогою цієї команди можна побудувати складний 

об’єкт, що займає сумарний об’єм всіх його складових. 

Віднімання (Subtract). Способи введення команди: 

- набрати з клавіатури команду: _subtract (ВЫЧИТАНИЕ); 

- викликати з меню: Modify > Solid editing > Subtract 

(Редактировать > Редактирование тела > Вычитание) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Solid > 

Boolean > Subtract (Фигура > Логические операции > 

Вычитание). 
За допомогою команди SUBTRACT можна видалити з тіл ті 

частини, які також належать іншій множині. Цю команду, 
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можна застосувати для отримання отворів в механічних деталях 

шляхом віднімання циліндрів. 

Перетин (Intersect). Способи введення команди: 

- набрати з клавіатури команду: _intersect (ПЕРЕСЕЧЕНИЕ); 

- викликати з меню: Modify > Solid editing > Intersect 

(Редактировать > Редактирование тела > Пересечение) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Solid > 

Boolean > Union (Фигура > Логические операции > 

Пересечение). 
За допомогою команди INTERSECT можна побудувати 

складне тіло, що займає об'єм, загальний для двох або більш 

перетинних тіл. Неперетинні частини об'ємів при цьому 

видаляються з креслення. 

Редагування тривимірних тіл. В AutoCAD є різні засоби 

зміни форми об’ємних тіл та їх відображення. Техніка 

редагування твердотільних 3D-об’єктів передбачає зняття 

фасок, спряження, побудову перетинів і розділення на частини. 

Для редагування тривимірних об’єктів також можна 

застосовувати команди, які використовуються для редагування 

2D-тіл. 

Спряження граней 3D-тіл виконується за таким алгоритмом: 

1. Задати у командному рядку команду _fillet 

(СОПРЯЖЕНИЕ), обрати з меню класичного AutoCAD пункт 

Modify > Fillet (Редактировать > Сопряжение) або натиснути в 

панельному меню Home > Modify (Главная > Редактирование) 

на кнопку . 

2. Вибрати ребро тіла спряження (верхнє коло на рис. 4.4). 

3. Задати радіус спряження. 

4. Продовжити вибір ребер або натиснути ENTER для 

переходу до побудови спряження. 

 



49 

 

 
Рис. 4.4. Приклад побудови спряження граней 3D-тіла 

 

Зняття фасок у 3D-тілах за таким алгоритмом: 

1. Задати у командному рядку команду _chamfer (ФАСКА), 

обрати з меню класичного AutoCAD пункт Modify > Chamfer 

(Редактировать > Фаска) або натиснути в панельному меню 

Home > Modify (Главная > Редактирование) кнопку . 

2. Вибрати ребро базової грані для фаски (ребро верхньої 

грані рис. 4.5). AutoCAD підсвічує одну або дві грані, суміжні з 

вибраним ребром. 
 

 
Рис. 4.5. Приклад побудови фаски граней 3D-тіла 

 

3. Для переходу до наступної грані ввести N (опція Next 

(Следующая)). Для підтвердження роботи з поточною 
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виділеною гранню натиснути ENTER. 

4. Задати довжину фаски для базової грані. Довжина фаски 

для базової грані вимірюється від вибраного ребра до точки на 

базовій грані. 

5. Задати довжину фаски для суміжної грані. Довжина фаски 

для суміжної грані вимірюється від вибраного ребра до точки на 

суміжній грані. 

6. Вказати ребра, на яких необхідно зняти фаски. 

Приклад створення 3D-моделі у програмі AutoCAD. На 

початку побудови 3D-моделі необхідно створити новий файл 

креслення. Це можна зробити за допомогою вибору команди з 

меню File > New (Файл > Создать). У вкладці «Выбор 

шаблона» можна вибрати один зі шаблонів, у нашому випадку 

це може бути acadiso3d. У якості прикладу використано 3D 

деталь з розмірами, які вказані на рис.4.6. 

 

  
Рис. 4.6. Зовнійшні вигляд деталі з розмірами  

 

Для початку роботи з 3D-об’єктами необхідно у вкладці 

«Рабочее пространство» встановити режим для роботи з 

тілами і поверхнями у трьохвимірному просторі «3D 

моделирование». На панельному меню у вкладці моделювання 

вибираємо «Ящик» і відкладаємо довжину, ширину і висоту 

нижньої частини деталі, як зображено на рис. 4.7. 

Далі будуємо верхній конус деталі. Для цього на панельному 

меню у вкладці «Моделирование» вибираємо «Конус». 

Переходимо на площину, шукаємо цент прямокутника і 

починаємо побудову вказавши у спливаючому меню радіус і 

висоту конуса (рис. 4.8).  
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Рис.4.7. Побудова ширини і висоти основи деталі 

 

За розмірами приведеними на рис. 4.6 потрібно задати 

верхню частину конуса діаметром 70. Для цього необхідно 

потягнути за маркер на вершині конуса і задати потрібний 

радіус (рис. 4.9). 
 

 
Рис.4.8. Побудова верхнього конусу деталі 

 

 
Рис.4.9. Встановлення розміру верхньої частини конуса 



52 

 

У конусі маємо отвір діаметром 55 мм. Для його виконання 

потрібно вибрати «Круг» на вкладці «Редактирование» 

панельного меню. Поставити цент круга у цент верхньої 

вершини конуса і задати відповідний розмір (рис. 4.10). 
 

 
Рис. 4.10. Виконання отвору у верхній частині конуса 

 

За допомогою команди «Выдавить» на вкладці 

«Моделирование», вказавши напрям до низу і висоту прорізу у 

40 мм, задаємо шлях прорізу у конусі (рис. 4.11). Після цього 

забираємо прорізаний циліндр із конуса. Для цього 

використовуємо команду «Вычитание» на вкладці панельного 

меню «Редактировать тело». Натискаємо на значок  на 

вкладці панельного меню та вказуємо фігуру з якої будемо 

проводити видалення, а після цього натискаємо Enter.  

 

 
Рис. 4.11. Встановлення напрямку прорізу 
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Для візуального перегляду деталі можна змінити вид 

представлення на вкладці панельного меню «Вид», вибравши 

потрібний вид, як показано на рис. 4.12. 

 

 
Рис. 4.12. Вибір виду представлення  

 

Наступним кроком є створення зрізів на нижній частині 

фігури. Для цього потрібно вказати межі зрізу, за допомогою 

команди «Отрезок» на вкладці «Редактирование» панельного 

меню. А також прорізати отвори, діаметром 20 мм, за 

допомогою команди «Круг» на вкладці «Редактирование» 

(рис. 4.13). Потім по утвореному контурі потрібно обрізати 

фігуру, за допомогою команди «Витягивание» на вкладці 

«Моделирование». У результаті отримаємо фігуру, як на рис. 

4.14. 
 

 
Рис. 4.13. Утворення зрізів на 

нижній частині фігури 

 
Рис. 4.14. Завершення процесу 

зрізування 
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Для виконання отвору внизу прямокутної основи, діаметром 

60 мм виконуємо ті ж самі дії, що і при побудові отвору у 

верхній частині конуса (див. рис. 4.10, 4.11). Вигляд виконаної 

фігури з отвором наведено на рис. 4.15. 

 

 
Рис. 4.15. Побудова отвору внизу прямокутної основи 

 

На завершення потрібно прорізати ще один отвір діаметром 

10 мм і висотою 15 мм. Для цього необхідно виконати дії, які 

показано на рис. 4.10 та 4.11. У результаті виконання всіх 

побудов отримаємо 3D-модель, яка представлена на рис. 4.16. 

 

 
Рис. 4.16. Кінцевий вигляд виконання 3D моделювання 

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 

тривимірних елементів у 3D просторі програми AutoCAD. 

2. За заданим варіантом виконати побудову 3D-деталі з 

відповідними розмірами.  
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Порядок виконання роботи 

1. Розглянути способи побудови 3D-об’єктів та приклад 

створення 3D-моделі у програмі AutoCAD з теоретичних 

відомостей. 

2. Вибрати деталь згідно варіанту з Додатку 3.  

3. Виконати побудову 3D-деталі аналогічно до прикладу, 

який описаний у теоретичних відомостях. 

4. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл для перевірки. До звіті необхідно додати креслення 

розробленої 3D-деталі у трьох стандартних виглядах (спереду, 

збоку, зверху) та ізометрію (3D- модель) на аркуші 

стандартного розміру (А3-А1) з розмірами та заповненим 

основним написом. 

 

Контрольні запитання. 

1. Опишіть способи побудови 3D-об’єктів у програмі 

AutoCAD. 

2. Як відбувається побудова 3D-тіл у програмі AutoCAD? 

3. Як відбувається створення 3D-тіл з двовимірних об’єктів у 

програмі AutoCAD? 

4. Як відбувається створення складних 3D-тіл у програмі 

AutoCAD? 

5.  Як відбувається редагування тривимірних тіл у програмі 

AutoCAD? 

6. Розкрийте особливість описаного прикладу створення 3D-

моделі у програмі AutoCAD. 
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Лабораторна робота №5 

Тема: Проектування і розробка документації (принципових 

схем і звітів) на електроустаткування  

Мета: Навчитися розробляти електричні схеми та звіти на 

електроустаткування за допомогою програм AutoCAD Electrical 

та КОМПАС-Электрик 

 

Теоретичні відомості 

Проектування електричних пристроїв, що містять 

різноманітні електричні компоненти являє собою особливу 

галузь конструкторської діяльності. Суттєвою відмінністю 

проектування електричних схем та звітів на 

електроустаткування є те, що більшість компонентів 

проектованого устаткування повинні мати декілька 

представлень. Одне із них – реальне (фізичне) зображення 

(креслення чи трьохмірна модель), друге – умовне графічне 

позначення для використання в принципових електричних і 

монтажних схемах. Крім того, усі ці компоненти повинні 

з’єднуватися як механічно так і лініями електричного зв’язку. 

Загалом, склад, а відповідно і сам процес проектування, будь-

якого електричного пристрою або системи можна умовно 

поділити на: електронні компоненти (друковані плати, монтажні 

схеми і т.п.); електротехнічні компоненти (реле, кнопки, 

сенсори, трансформатори і т.п.); механічні частини (корпус, 

елементи кріплення і т.п.).  

Розробка електричних пристроїв – складна і багатогранна 

задача, що вимагає великого комплексу інструментів. Все це 

стає більш актуальним при умові, що проектування подібних 

виробів дуже поширене у сучасному виробництві. Майже кожен 

пристрій містить в собі ті чи інші електричні компоненти. На 

жаль, практично ні одна сучасна CAD-система не забезпечує 

повного циклу розробки – від принципових електричних схем, 

розміщення елементів на друкованих платах, трасування і до 

проектування корпусів, блоків і створення конструкторської 

документації, підготовки програм для ЧПУ та формування 

технологічних процесів. Тому користувачам доводиться 

працювати з різними системами і вирішувати питання їх 



57 

 

сумісності. Ще одна задача, яку необхідно вирішувати у процесі 

проектування це – створення і накопичення баз даних елементів 

і пристроїв та їх використання при компонуванні вузлів. 

Одним з широковживаних програмних продуктів, що 

використовується для проектування електричних систем є 

AutoCAD Electrical. Він є окремим модулем системи 

автоматизованого проектування AutoCAD, містить всі базові 

елементи цієї системи, а також має повний набір функцій для 

електротехнічного проектування. У AutoCAD Electrical до 

стандартних функцій AutoCAD додані спеціалізовані 

електротехнічні можливості, що прискорює створення креслень 

електричних систем (наприклад, обрізка проводів, копіювання та 

видалення компонентів або всього електричного кола, 

переміщення і вирівнювання компонентів та багато іншого). 

Проект створений AutoCAD Electrical має деревоподібну 

структуру, що відображається в диспетчері проектів. 

Інформація про кожен аркуш проекту може включати до десяти 

параметрів. Крім цього в диспетчері проектів можна попередньо 

переглянути аркуш проекту або інформацію про кожен файл 

проекту. Всі дії з проектом, зокрема відкриття, закриття, 

створення нового проекту, друк і багато іншого виконуються з 

диспетчера проектів. 

Використання AutoCAD Electrical у проектуванні 

принципових електричних схем дає змогу значно скоротити час і 

зусилля на проектування завдяки застосуванню таких засобів: 

1) Автоматизація рутинних процесів: автоматичне 

маркування ліній зв’язку, позиційних позначень, контактів, 

тощо. 

2) Бібліотеки умовних графічних позначень (УГП). 

3) Бази даних у форматі MS Aссess з можливістю їх 

поповнення. 

4) Багаторазове використання ділянок схем в різних 

проектах, як за допомогою інструментів копіювання, так і за 

допомогою збереження цих ділянок в меню УГП, що доступне 

для будь якого проекту. 

5) Швидке внесення змін за допомогою технології 

наскрізного проектування, тобто при внесенні змін в будь-яку 
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частину проекту вони автоматично відображаються у всіх його 

складових. 

6) Автоматичний і автоматизований контроль помилок. 

7) Зручні інструменти роботи з клемниками, що дає змогу 

набирати їх з окремих клем і дозволяє використовувати в схемах 

з будь-якою кількістю клем. Цей процес відбувається 

автоматично. 

8) Зручні інструменти роботи з програмованими логічними 

контролерами (ПЛК). Схеми ПЛК можуть створюватися з будь-

якою кількістю входів і виходів, що позбавляє необхідності 

додавати в меню УГП нові ПЛК. 

9) Автоматизоване генерування текстових вихідних 

документів, що входять у склад конструкторської документації. 

Інтерфейс AutoCAD Electrical має всі можливості та подібний 

до звичайного AutoCAD (рис. 5.1), але на відміну від нього має 

додатковий комплекс інструментів спеціального призначення. 

AutoCAD Electrical має три стандартних робочі простори (рис. 

5.2): 

- AutoCAD 2D рисування і анотації; 

- AutoCAD 3D моделювання; 

- AutoCAD Electrical. 

 

 
Рис. 5.1. Інтерфейс програми AutoCAD Electrical 
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Рис. 5.2. Вибір стандартних просторів у програмі AutoCAD 

Electrical 

 

Основним елементом будь якої програми для проектування 

електричних систем є наявність бібліотеки умовних графічних 

позначень (УГП) електричних схем. У програмі AutoCAD 

Electrical наявні всі необхідні бібліотеки УГП, які 

застосовуються для проектування електричних систем згідно з 

Держстандартами України. Доступ до необхідного позначення 

здійснюється за допомогою «Графическое меню», яке 

знаходиться на панелі «Вставить компонент» у вкладці 

«Схема» (рис. 5.3).  
 

 
Рис. 5.3. Зовнішній вигляд меню «Вставить компонент» для 

додавання компонентів електричних схем 
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Для полегшення розуміння принципу дії електричних схем 

на кресленнях схем можуть приводитися пояснюючі написи. До 

них відносяться: короткі пояснення принципу дії і послідовності 

включень елементів схеми, відомості режимів роботи, часові та 

інші характеристики схем, пояснення дії захисту і сигналізації. 

Ці короткі пояснення приводяться в описах роботи елементів 

схеми з посиланням на УГП, наприклад: «При натисканні 

кнопки спрацьовує реле К1, що своїм контактом К1.1 включає 

соленоїдний клапан... і т.д.». 

Невід’ємною частиною будь якої електричної схеми є 

«Перелік елементів та пристроїв», який виконується у 

табличному вигляді або у вигляді специфікації. Для створення 

специфікацій у AutoCAD Electrical можна використовувати 

інструмент генерування звітів. Для цього необхідно перейти на 

вкладку «Reports» та натиснути кнопку «Reports». В отриманому 

списку вибрати «Bill of Material» («Спецификация»). В 

отриманому вікні перевірити чи для кожного компоненту 

вказано виробника та номер за каталогом (марку, модель 

пристрою).  

Якщо виробник (MFG) та номер за каталогом (CATALOG) у 

певного компонента відсутні, необхідно скасувати створення 

специфікації та відредагувати атрибути елемента, додавши 

відсутні дані у відповідні поля. Після цього, специфікацію 

необхідно розмістити на кресленні натиснувши кнопку «Put on 

Drawing». 

Для розробки електричних схем за допомогою програми 

КОМПАС-3D використовують спеціалізований додаток для 

автоматизованого проектування електрообладнання  

КОМПАС-Электрик. Він працює у вигляді вмонтованого у 

програму КОМПАС-3D модуля і може застосовуватися для 

розробки будь-яких електротехнічних об’єктів у яких 

використовується провідниковий монтаж.  

Електричні пристрої частіше всього складаються із 

стандартних елементів, що використовуються у багатьох 

установках. Створення і накопичення бази за такими 

пристроями значно пришвидшує процес проектування. 

Стандартні засоби КОМПАС-Электрик і КОМПАС-3D 
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дозволяють створювати власні бази даних (бібліотеки 

компонентів) (рис. 5.4). 

 

 
Рис. 5.4. Тривимірна бібліотека електротехнічних 

комплектуючих 

 

Бібліотечними компонентами можуть бути як окремі деталі, 

так і зборки. При формуванні бібліотеки засобами КОМПАС-3D 

дуже зручно відразу створювати у файлі деталі і відповідний 

об’єкт специфікації (рис. 5.5). Ця операція вирішує відразу 

декілька задач: 1) при додаванні компоненту в зборку не 

потрібно окремо створювати специфікацію і 2) вставляючи інші 

компоненти, система автоматично просумовує їх кількість. 

Процес виконання проекту електротехнічної частини виробу 

організовується за допомогою спеціального «Менеджер 

проэкта». При цьому, до його складу можна включити не лише 

документи, створені безпосередньо в КОМПАС-Электрик, але і 

будь-які документи розроблені у КОМПАС-3D. Після 

завершення проектування усіх схем та таблиць, а також 

попереднього розміщення компонентів на робочих поверхнях 

майбутнього виробу, можна приступати до тривимірного 

компонування. 
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Рис. 5.5. Зображення компонента бібліотеки 

 

Тривимірне компонування панелей проводиться за 

допомогою стандартних функцій по роботі зі зборками 

КОМПАС-3D. Створені раніше стандартні деталі беруться з 

бібліотеки і за допомогою механізму спряження розміщуються 

на попередньо створену несучу конструкцію (панель, стійка, 

щит і т.д.). Для встановлення елементів кріплення їх вибирають 

з стандартної «Библиотеки крепежа» вказавши отвір, в якому 

розміщується кріплення і торцеву поверхню, по якій кріплення 

буде вирівняне (рис. 5.6). 

До складу окремого пристрою можуть входити не лише 

окремі електротехнічні компоненти, але і вбудовані пристрої на 

базі плат друкованого монтажу. Це можуть бути різноманітні 

системи керування і контролю параметрів, підсилювачі, давачі 

та ін. У КОМПАС-Электрик є окремий модуль для випуску 

текстової і конструкторської документації та тривимірних 

моделей друкованих плат, на основі даних, отриманих із 

електронних САПР (OrCAD, P-CAD, Protel та ін.). 

Тривимірна модель друкованої плати створюється на основі 

файлів, що імпортуються із ECAD-систем (рис. 5.6). У 

результаті роботи конвертера отримаємо тривимірну модель 

друкованої плати і бібліотеку елементів, що у ній 

використовується.  
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Рис. 5.6. Конвертована 3D-модель плати 

 

Вихідною інформацією для створення текстової документації 

являється звіт «BOM (Bill of Materials)», який формується ECAD 

системами. Для повної інтеграції звітів «BOM» з кресленням 

принципової електричної схеми необхідно передати їх з ECAD в 

КОМПАС-3D. Ця операція найчастіше виконується через 

формати PDIF, DFX та ін. В склад системи КОМПАС-3D для 

цих цілей використовується «Библиотека поддержки PDIF»: 

вона виконана як стандартний додаток і запускається з 

«Менеджера библиотек».  

Щоб почати розробляти принципову електричну схему 

необхідно спочатку підключити КОМПАС-Электрик. Для цього 

запускають «Редактор схем и отчетов» в меню «ПУСК», після 

чого відбудеться запуск системи КОМПАС-3D, а разом з нею і 

КОМПАС-Электрик. Далі створюємо новий проект в 

«Менеджер проектов», для цього в закладці «Создать» 

вводимо ім’я проекту (рис. 5.7). Усі маніпуляції з проектом, 

документами, які до нього входять, а також переліком 

комплектуючих, які задіяні в ньому відбуваються через 

«Менеджер проектов». Тобто, щоб зберегти проект, створити в 

ньому новий тип документу, видалити документ з переліку 

раніше створених необхідно користуватися діалоговим вікном 

«Менеджера проектов». Після цього створюємо у проекті 
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новий документ «Схема електрична принципова» (рис. 5.8.). 

 

 
Рис. 5.7. Панель створення проекту 

 

 
Рис. 5.8. Створення нової схеми проекту 

 

У результаті виконання таких дій з’являється робоча 

область КОМПАС-3D. Для підключення КОМПАС-

Электрик необхідно на панелі натиснути праву клавішу 

миші і з випадаючого меню вибрати КОМПАС-Электрик 

(рис. 5.9). Після проведених цих маніпуляцій з’явиться 

інструментальна панель КОМПАС-Электрик (рис. 5.10). 
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Рис. 5.9. Підключення панелі інструментів КОМПАС-Электрик 

 

 
Рис. 5.10. Панель інструментів КОМПАС-Электрик 

 

На панелі інструментів КОМПАС-Электрик знаходяться такі 

елементи: 

 - менеджер проекту (згортає і  вікно менеджера проектів); 

 - копіювати елемент проекту; 

 - вставити елемент проекту; 

 - відновити і повторити;  

 - обрив лінії зв’язку; 

 - клема;  

 - заземлення;  

 - з’єднання з корпусом;  

 - екранування; 

 - об’єднання в кабель; 

 - структура; 

 - коаксіальний кабель;  

 - позначення кабелю;  
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 - планка заземлення; 

 - точка заземлення; 

 - перемичка; 

 - точка з’єднання; 

 - лінія зв’язку; 

 - групова лінія зв’язку; 

 - електрична шина; 

 - УГО (відкриття бібліотеки елементів); 

 - запис об’єкту специфікації; 

 - розставити УГО МКС; 

 - вставити серію УГО; 

 - розставити клеми; 

 - відновити перехресні посилання 

 - автоматичне маркування; 

 - параметри системи; 

 - вибір бази даних.  

Для вибору необхідного елементу схеми потрібно 

використовувати команду «УГО» (рос., условные графические 

обозначения), після виклику якої з’явиться діалогове вікно (рис. 

5.11), в якому і здійснюється вибір елемента. 
 

 
Рис. 5.11. Діалогове вікно «Выбор УГО» за допомогою якого 

здійснюється вибір позначення елементів схеми 
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Після цього, виконується розстановка елементів на схемі їх 

з’єднання лініями зв’язку використовуючи опцію «Линии 

электрической святи» і завершують формування принципової 

електричної схеми шляхом оформлення звітів, специфікацій та 

пояснюючих написів на кресленні схеми. 

 

Програма роботи  
1. Розглянути особливість використання програм AutoCAD 

Electrical та КОМПАС-Электрик для розробки електричних 

систем.  

2. Використовуючи базу умовних графічних позначень 

навчитися розробляти принципові електричні схеми. 

 

Порядок виконання роботи 

1. Частина 1. Розглянути приклад розробки принципових 

електричних схем з використанням програми AutoCAD 

Electrical, що описаний у теоретичних відомостях. 

2. Розробити принципову електричну схему у програмі 

AutoCAD Electrical (варіанти схем приведені у Додатку 4). 

3. Розробити опис роботи принципової схеми та «Перелік 

елементів схеми» у вигляді специфікації у програмі AutoCAD 

Electrical. 

4. Частина 2. Розглянути приклад розробки принципових 

електричних схем з використанням програми КОМПАС-

Электрик, що описаний у теоретичних відомостях. 

5. Розробити принципову електричну схему у програмі 

КОМПАС-Электрик (варіанти схем приведені у Додатку 4). 

6. Розробити опис роботи принципової схеми та «Перелік 

елементів схеми» у вигляді специфікації у програмі КОМПАС-

Электрик. 

7. Результати роботи оформити у вигляді звіту. 

 

Контрольні запитання 

1. У чому суть розробки електричних пристроїв з 

використанням CAD-програм? 

2. Яка особливість програми AutoCAD Electrical? 
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3. Які переваги використання програми AutoCAD Electrical 

при проектуванні принципових електричних схем? 

4. Яка особливість інтерфейсу програми AutoCAD Electrical?  

5. Як використовуються бібліотеки УГП у програмі 

AutoCAD Electrical? 

6. Яка специфіка створення специфікацій у AutoCAD 

Electrical? 

7. Яка особливість програми КОМПАС-Электрик? 

8. У чому суть роботи бібліотеки тривимірних компонентів 

та «Менеджера проекта» програми КОМПАС-Электрик? 

9. У чому полягає специфіка розробки електричних схем у 

КОМПАС –Электрик? 

10. Опишіть складові панелі інструментів КОМПАС-

Электрик. 
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Лабораторна робота №6 

Тема: Розробка принципових електричних монтажних схем 

Мета: Навчитися проектувати монтажні схеми (з’єднань) 

графічним способом з використанням програми AutoCAD 

Electrical та КОМПАС-Электрик 

 

Теоретичні відомості 

Принципові електричні монтажні схеми (з’єднань) 

розробляються для відображення розташування елементів та 

пристроїв їх взаємодії між собою та з іншими пристроями. Ці 

схеми використовуються для виконання монтажних робіт. Вони 

виконують без дотримання масштабу, на них зображують усі 

елементи і пристрої для яких виконуватиметься монтаж, 

наприклад у щитах або пультах. При цьому, їх розташування на 

монтажній схемі повинне приблизно відповідати дійсному 

розташуванню. 

На монтажних схемах відображаються:  

- пристрої та елементи у вигляді прямокутників або умовних 

графічних позначень з вказівкою усіх контактних з’єднань через 

які здійснюються електричний зв’язок і від яких відходять 

провідники; 

- провідники з вказівкою марки, перерізу та при потребі 

кольору;  

- кабелі з вказівкою марки, кількості і перерізу жил.  

На простих схемах показують усі провідники (пряме 

з’єднання), якими з’єднуються апарати, прилади та інші 

елементи. У складних схемах для спрощення виконання і 

читання застосовують адресний, або змішаний спосіб. Для цього 

поруч з умовним позначенням пристроїв та елементів 

проставляють: порядковий номер (у чисельнику), починаючи з 

першого і позиційне позначення (у знаменнику), відповідно до 

принципової схеми. Кінці провідників маркують, тобто наносять 

адресу: перша цифра - порядковий номер апарату, друга - номер 

виводу до якого підключений кінець провідника. Таким чином 

формується повна картина монтажу та з’єднання елементів і 

пристроїв схеми. 

Для прикладу розглянемо принципову електричну схему 
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керування електродвигунами (рис. 6.1), перелік елементів до неї 

подано у табл. 6.1. Усі елементи розглянутої схеми мають одно- 

або дволітерні позначення. Наприклад, двигуни 1М, 2М, 

контактори КМ1, КМ2, перемикачі 1SА1, 2SА1, сигнальні 

лампочки 1НL1, 2НL1 і т.д. 

 

 
Рис. 6.1. Принципова електрична схема керування 

електродвигунами 

 

З’єднувальні провідники позначені арабськими цифрами, а 

номери провідників, що мають загальну точку - однакові. Так, 

кнопка 1SВ1 з’єднана одним проводом з 1SВ2 та з замикаючим 

додатковим контактом КМ1.1 контактора КМ1, при цьому вони 

позначені номером 102. На цій схемі власні маркування 

комутуючих апаратів не позначені, що необхідно врахувати при 

складанні монтажної схеми. 

Проаналізувавши принципову електричну схему (див. рис. 

6.1) бачимо, що котушки магнітнних пускачів КМ1, КМ2 будуть 

замикати робочі контакти і подавати напругу на двигуни 1М, 

2М при натисканні кнопок 1SВ2 та 2SВ2. Це можна здійснити 

тільки у ручному режимі, коли перемикач 1SА1, або 2SА1 

перебуває в положенні Р. При цьому, контактори КМ1, КМ2 

через додаткові контакти КМ1.1 та КМ2.1 заблокуються. 
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Вимикання двигунів 1М та 2М у цьому режимі здійснюється 

при натисканні на кнопку 1SВ1 або 2SВ1. 
Табл. 6.1.  

Перелік елементів та пристроїв до принципової електричної 

схеми (рис. 6.1) 
Позиційне 

позначення 

Назва Кіль-

кість 

Примітка 

На механізмі 

1М, 2М Двигун асинхр. 3ф., тип МDХМА90-

32,1,5кВт, 1410хв
-1

, 380В, 3,5А 

2  

На щиті місцевого управління (ЩМУ) 

QF Вимикач автоматичний ТеmDіn 3С, 

In=10A; Un=380В 

1  

КМ1, КМ2 Контактор типу 11МС6.10, In=6А, 

 Uк=220В, 1 зам. дод. Контакт 

2  

КК1, КК2 Реле теплове, тип 11RF9,5, Iср=3-5А 2  

1QF1, 2 

QF1 

Вимикач автоматичний ТеmDіn 1С, 

In=1A; Un=220В 

2  

1SB1, 

2SB1 

Кнопка управління 8LМ2ТВ104.1 

розмірний контакт, штовхач червоного 

кольору 

2 На 

дверях 

ЩМУ 1 

1SB2,  

2SB2 

Кнопка управління 8LМ2ТВ102.1 зам. 

контур, штовхач чорного кольору 

2 На 

дверях 

ЩМУ 1 

1SА1, 2SА1 Перемикач, 3-поз. стабільний  

8ДМ2ТS130 

2 На 

дверях 

ЩМУ 1 

1НL1, 2НL1 Арматура світлосигнальна зелена 

8LР2ТIL223 з лампою розжарювання 

220В змінного струму 

2 На 

дверях 

ЩМУ 1 

 

У положенні А перемикачів 1SА1, 2SА1, що відповідає 

автоматичному режиму, двигуни будуть вмикатися автоматично 

через контакти реле К3, К4, які управляються контролером (на 

даній схемі не показаний). На це вказує пунктирна лінія навколо 

контактів і посилання на певний номер аркуша принципової 

схеми де вони детально розглянуті (ЩА2). У випадку 
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перевантаження двигуна спрацьовує теплове реле КК1 або КК2 

розмикаючий контакт, якого припиняє подачу напруги на 

котушку контактора КМ1 або КМ2, коло розмикається і 

двигун(и) зупиняється. 

На основі принципової електричної схеми розроблена 

монтажна схема (рис. 6.2). Розташування апаратури на цій схемі 

приблизно відповідає фактичному її розміщенню в конструкції 

щита керування. Схема виконана змішаним способом, тобто 

лінії підключення частини апаратів показані прямим 

з’єднанням, наприклад 
 

   
 
 

  
 

 

   
, а підключення інших 

апаратів, наприклад 
 

    
 

 

    
 

 

    
 – адресним. 

 

 
Рис. 6.2. Монтажна схема щита місцевого керування  

 

Для чіткого розуміння зв’язку всіх пристроїв біля кожного 

апарату проставлений порядковий номер і позиційне 

позначення, наприклад, біля клемної колодки – 
 

   
, ввідного 

автоматичного вимикача – 
 

  
 і т.д. Всередині кожного елемента 

знаходиться нумерація виводів відповідно до заводського 
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маркування. 

Як було згадано вище, монтаж силових кіл виконується 

прямим з’єднанням провідників, а кіл керування адресним, 

наприклад, частина електричного кола 104 (див. рис. 6.1) 

виконана в такий спосіб. Виводи 2 і 4 перемикача 1SА1 (апарат 

9) перемкнуті між собою, а з вивода 2 виходить провід 11-1 

(апарат 11, вивід 1). Другий кінець цього проводу на лампочці 

1НL1 (апарат 11) має маркування 9-2 (апарат 9, вивід 2). Крім 

того, з виводу 1 апарата 11 відходить провід 1-12 (на клемну 

колодку ХТ1), який на другому кінці має маркування 11-1. 

Провід, що з’єднує клему 12 клемної колодки ХТ1 з контактом 

теплового реле КК1, має маркування 5-95 з боку клемної 

колодки і 1-12 з боку теплового реле КК1. Таким чином 

виконується адресація всіх елементів схеми у відповідності до 

вихідної принципової електричної схеми. Такий підхід, дає 

змогу чітко розуміти взаємодію елементів, виконати монтаж, а 

також бачити зв’язок принципової схеми з монтажною. 

На полі креслення монтажної схеми зазначається, які 

проводки яким проводом монтувати, крім того, тут 

зазначаються способи ведення монтажу. Наприклад: «Монтаж 

виконати з використанням перфорованих коробів 25Х25 мм з 

їхньою установкою за місцем», «Провода, що з’єднують 

клемник ХТ1 з апаратурою на дверях шафи, виконати у вигляді 

джгута в спіральній трубці діаметром 10 мм» і т.п. 

Також виконання монтажної схема передбачає розробку 

переліку комплектуючих елементів. Цей перелік можна 

виконати автоматично, у вигляді специфікації, використовуючи 

систему КОМПАС-Электрик (рис. 6.3) або AutoCAD Electrical. 

Його можна виконати, як на всі комплектуючі вироби так і на ті, 

які присутні в конкретній схемі проекту, тобто перелік 

елементів може формуватися до будь-якої схеми. 

Перелік елементів у більшості CAD-систем створюється в 

автоматичному режимі і не потребує участі користувача. Всі 

дані для його заповнення система отримує з проекту і бази 

даних комплектуючих. Однотипні комплектуючі вироби 

автоматично сумуються і групуються. Відомість закупівельних 

виробів (як і перелік елементів), формується в автоматичному 
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режимі. Відомість створюється на увесь проект і до неї 

потрапляють тільки ті вироби, які в базі даних мають відповідну 

ознаку. 

 

 
Рис. 6.3. Фрагмент переліку елементів 

 

Розглянемо приклад складання переліку елементів схеми за 

допомогою програми КОМПАС-Электрик. Для цього 

необхідно вибрати «Редактор схем и отчетов» в меню 

«ПУСК». Після чого відбудеться запуск системи КОМПАС-3D, 

а разом з ним і КОМПАС-Электрик. Для того, щоб створити 

новий проект використовуємо «Менеджер проектов», для цього 

в закладці «Создать» вводимо назву проекту. Далі потрібно 

створити в проекті новий документ, наприклад «Схема 

електрична монтажна».  

Потім потрібно накреслити монтажну схему, або 

завантажити вже створену. Для того, щоб виконати автоматичне 

створення переліку елементів (див. рис. 6.3) всі вони мають бути 

вибрані з бази елементів, у випадку самостійного креслення 

якогось елементу у автоматичний перелік він не потрапить. 

Такий елемент потрібно додати вручну. Для вибору необхідного 

елемента схеми потрібно використовувати команду «УГО» 
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(условные графические обозначения), після виклику якої 

з’явиться діалогове вікно таке саме, як при створенні 

принципової схеми (див. рис. 5.11), в якому здійснюється вибір 

необхідного елемента. 

Для вибору елементу з бази даних необхідно ввести його 

позиційне позначення за допомогою вікна «Позиционное 

обозначение» (рис. 6.4). 
 

 
Рис. 6.4. Вигляд вікна «Позиционное обозначение» 

 

В закладці «Специификация» (рис. 6.5) вибрати закладку 

«Изменить», а з бази даних здійснити вибір відповідного 

елемента. Потім виконати маркування ліній електричного 

зв’язку, виділивши усі відрізки відповідного провідника 

затиснувши клавішу «Shift», викликати команду 

«Автоматическая маркировка» на панелі КОМПАС-Электрик 

(рис. 6.6). 
 

 
Рис. 6.5. Закладка «Специификация»   
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Рис. 6.6. Кнопка «Автоматическая маркировка» 

 

Після цього, заповнити діалогове вікно «Автоматическая 

растановка маркировки» (рис. 6.7), при цьому, різні лінії 

можуть мати різне маркування, наприклад А1, F2, тощо. 

 

 
Рис. 6.7. Діалогове вікно «Автоматическая растановка 

маркировки» 

 

У «Менеджер проектов» створюємо новий тип документу 

«Перечень элементов», а при потребі документ «Ведомость 

покупных изделий». 

Розробка принципової монтажної схеми за допомогою 

програми AutoCAD Electrical. Оскільки, монтажна схема є 

також принциповою електричною схемою, то її розробка 

відбувається за допомогою подібних інструментів, що і для 

розробки звичайної принципової електричної схеми. Для цього 

використовується «Графическое меню», яке знаходиться на 

панелі «Вставить компонент» у вкладці «Схема» (рис. 6.8). Тут 

можна вибрати різні «ІЕС: графические образы для схем», 

наприклад «Реле/контакты», «Клемы/Соединители» та ін. 
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Рис. 6.8. Вигляд меню «Вставить компонент»  

 

Для того, щоб вставити компонент з графічного меню 

необхідно: Клацнути на вкладці «Схема» панелі «Вставить 

компонент» список, що розкривається. У діалоговому вікні 

«Вставить компонент» вибрати початкову орієнтацію 

компонента - по горизонталі або по вертикалі. Якщо потрібно 

вставити компонент без позиційного позначення, встановіть 

прапорець «Без поз. Обозн.». При відсутності позиційного 

позначення відображається значення за замовчуванням. Далі 

потрібно вибрати компонент для вставки, наприклад, «Кнопки 

включения», а потім значок або тип компонента зі списку в лівій 

частині, потім вказати точку вставки на кресленні і натиснути 

«ОК». 

Крім «Графическое меню» можна також використовувати 

вкладку «Монтажная панель», яка знаходиться поряд зі 

вкладкою «Схема», де можна вибрати готові клемні колодки за 

допомогою елементу «Редактор» (рис. 6.9) та інші елементи 

для розробки окремих частин монтажних схем. Також на цій же 

панелі є елемент «Формирование таблиц» (рис. 6.10), який дає 

змогу виконати таблицю з’єднань. 
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Рис. 6.9. Вигляд елементу «Редактор» 

 

 
Рис. 6.10. Вигляд елементу «Формирование таблиц» 

 

Після виконання всіх побудов зможемо створити проект 

готової монтажної схеми, а також перелік її елементів у вигляді 

специфікації. 

 

Програма роботи 

1. Розглянути основні правила виконання принципових 

монтажних схем. 
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2. На основі принципової електричної схеми розробити 

принципову монтажну схему. 

 

Порядок виконання роботи 

1. Ознайомитися з правилами виконання монтажних схем 

графічним та табличним способами. 

2. Виконати монтажну схему за розробленою на попередній 

лабораторній роботі принциповою електричною схемою 

використовуючи програму КОМПАС-Электрик (Частина 1) та 

AutoCAD Electrical (Частина 2).  

3. Розробити перелік використаних елементів у формі 

специфікації використовуючи програму КОМПАС-Электрик 

(Частина 1) та AutoCAD Electrical (Частина 2). 

4. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4. 

 

Контрольні запитання 

1. Що таке принципова електрична монтажна схема? 

2. Яка особливість побудови монтажних схем? 

3. Яка особливість розробки таблиці з’єднань? 

4. Вкажіть в якому порядку розробляють принципові 

електричні монтажні схеми. 

5. Як графічно позначаються елементи, пристрої і лінії 

зв’язку на монтажних схемах? 

6. Які методи використовуються при з’єднанні провідників 

на монтажних схемах? 

7. Яка особливість маркування провідників монтажної 

схеми? 

8. Як виконується розробка переліку комплектуючих 

елементів монтажної схеми? 
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Лабораторна робота №7 

Тема: Проектування елементів інтегральних схем з 

використанням мови VHDL 

Мета: Навчитися розробляти програми поведінки і 

моделювання інтегральних схем за допомогою мови VHDL  

 

Теоретичні відомості 

Сучасні мови проектування є засобами автоматизації 

проектування різних систем. Ефективність застосування різних 

технологій проектування визначається ефективністю мов 

проектування. Основним критерієм мови проектування є її 

уніфікація, що дає змогу проектувальникам неодноразово 

використовувати розроблені прогамні засоби та компоненти, 

скоротивши таким чином час та зусилля на процес 

проектування. 

Основні вимоги, щодо використання мов проектування: 

- застосування технології нисхідного проектування; 

- надійність розроблених систем; 

- мобільність, тобто здатність переносити програмні компоненти 

на різні об’єкти; 

- програмний супровід розробленої системи протягом всього її 

життєвого циклу; 

- простота написання програм та зручність обміну інформацією 

проектувальника з обчислювальним середовищем; 

- раціональне розмежування засобів мови на різних етапах 

проектування та між різними проектвальниками. 

Найбільшого поширені в галузі проектування електричних 

систем набули такі мови: 

1. Мови проектування апаратури:  

  - VHDL - мова опису апаратних засобів інтергальних схем; 

  - Verilog - мова опису апаратних засобів та моделювання 

електронних систем; 

  - SystemC – мова проектування і веріфікації моделей 

системного рівня, реалізована у вигляді C++ бібліотеки. 

2. UML – мова графічного опису об’єктного моделювання та 

ін. 

Однією з найбільш поширених мов проектування 
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інтегральних схем та інших елементів електронних систем є 

мова VHDL (Very high speed integrated circuits Hardware 

Description Language). Ця мова була розроблена у 1980 році в 

результаті реалізації в США проекту по створенню 

надшвидкісних інтегральних схем. У 1987 році Інститутом 

Інженерів з Електрики та Електроніки (IEEE) вона була визнана 

стандартною для розробки електронних систем у США. Зараз 

VHDL є найбільш поширеною у світі мовою такого 

призначення, її застосовують при розробці багатьох систем 

автоматизованого проектування. 

VHDL— це мова опису апаратних засобів інтегральних схем 

та багатьох інших елементів у системах автоматизованого 

проектування. Основне її призначення це використання у якості 

інструментального засобу проектування програмованих 

логічних інтегральних схем (ПЛІС) та надвеликих інтегральних 

схем (НВІС). VHDL базується на принципі нисхідного 

проектування і є універсальною для проектування виробів 

цифрової електроніки. 

На даний час мова VHDL використовується в якості 

міжнародного стандарту опису обчислювальних систем будь 

якого рівня складності (мікросхема, плата, блок, пристрій, ЕОМ, 

комплекс, тощо). Вона може бути використана на всіх етапах 

розробки електронних систем: проектування, верифікація, 

синтез і тестування апаратури, обмін даними про проект між 

різними системами автоматизованого проектування (САПР). 

У мові VHDL важливе значення надається типам даних 

оскільки вони дають змогу визначати особливість розробленого 

елементу чи пристрою. Ця мова використовується для розробки 

різноманітних варіантів апаратних проектів, тому засоби 

контролю типів даних мають велике значення. Такий підхід, дає 

розробнику можливість представити сукупність ліній зв’язку 

(шин) у вигляді масиву бітів або цілого числа. 

Кожен тип даних у VHDL має певний набір прийнятих 

значень, формат збереження та передачі даних і набір 

дозволених операцій. У цій мові визначена значна кількість 

різних типів даних, а також використовуються засоби для 

утворення користуватських типів даних. У VHDL 
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використовується скалярні і агрегатні типи даних. Об’єкт, який 

віднесений до скалярного типу, розглядається як закінчена 

одиниця інформації. Агрегатні типи даних являють собою 

впорядковану сукупність скалярних одиниць, об’єднаних 

однаковим ім’ям. Крім того, типи даних поділяються на базові 

та користуватські. 

Розроблений на мові VHDL проект являє собою опис явищ у 

дискретних системах. Такі явища представляються різними 

категоріями даних: константи, сигнали та змінні. Константи 

(constant) використовують для визначення сталих значень, які 

залишаються незмінними у всьому проекті. Сигнали (signal) – це 

інформація, що передається між елементами проекту і може 

бути представлена у вигляді вхідних та вихідних даних 

розроблюваного обладнання. Змінні (variable) – це інформаційна 

одиниця, яка використовується для опису внутрішніх операцій у 

елементах проекту, вони можуть синтезуватись у комірках 

пам’яті та змінюватися у ході виконання операцій. 

Як і у будь якій мові програмування у мові VHDL 

використовуються оператори, які можна розділити на дві групи: 

послідовні і паралельні. Послідовні оператори (sequential 

statement) подібні до операторів багатьох мов програмування. 

Такі оператори обов’язково використовуються для опису 

послідовних процесів у частинах програм process, або в 

підпрограмах procedure чи function і виконуються послідовно 

один за одним у порядку запису. Паралельні оператори 

(concurrent statement) виконуються при будь яких змінах 

сигналів, що задані у вигляді вихідних даних. Такі оператори 

виконуються не за послідовним принципом, а тоді, коли 

реалізація інших операторів програми створила умови для 

їхнього виконання. У мові VHDL також використовується 

багато інших операторів, про їх особливість та способи 

використання детально описані у спеціальній літературі. 

Розглянемо особливість описів схем на мові VHDL. Опис 

будь якої схеми або її фрагменту складається з двох частин. 

Перша, називається сутністю (entity), містить опис зовнішнього 

інтерфейсу схеми (перелік входів, виходів та інших 

компонентів). Друга називається архітектурою (architecture) і 
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містить опис, що визначає внутрішню будову та 

функціонування схеми. 

Приклад опису сутності на мові VHDL: 

ENTITY <ім’я сутності> IS 

<вхідні і вихідні порти>; 

[< фізичні та інші параметри>; ] 

END [ [entity] ім’я_сутності ] 

Щоб написати повну VHDL-програму, потрібно описати всі 

вхідні і вихідні сигнали і визначити тип кожного з них. Опис 

сутності починається ключовими словами ENTITY ... IS. Він 

містить ім’я сутності і опис її зовнішніх виводів, що 

називаються портами. Крім того, опис може включати інші 

зовнішні параметри, такі як часові і температурні залежності 

тощо.  

Завершується опис ключовим словом END, за яким (для 

зручності сприйняття тексту програми і додаткового контролю 

коректності блочної структури) бажано вказати реквізити блоку, 

що завершується. В даному випадку це entity та ім’я сутності. 

Опис архітектури може виконуватись двома способами: 

- як опис структури схеми (structural), тобто схеми з’єднань її 

складових елементів – схем нижчого ієрархічного рівня, аж до 

рівня з’єднання вентилів (dataflow); 

- як опис поведінки схеми (behavioral). 

Опис архітектури починається ключовими словами 

ARCHITECTURE ... OF ... IS, між якими вказується ім’я 

архітектури та ім’я сутності, якій вона відповідає. Далі 

вказуються декларації та тіло архітектури. 

Приклад опису архітектури: 

ARCHITECTURE <ім’я архітектури> OF <ім’я сутності> 

IS 

<декларації типів, сигналів, констант та ін.> 

BEGIN 

<тіло архітектури> 

END [ [architecture] <ім’я­_архітектури>] 

Розглянемо опис схеми на мові VHDL на прикладі опису 

роботи принципової схеми D-тригера. D-тригери це пристрої, 

які мають один інформаційний вхід, який працює так, що сигнал 
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на виході після перемикання дорівнює сигналу на вході D до 

перемикання, тобто Qn+1=Dn. Основне призначення D-тригерів 

– це затримка сигналу, який поданий на вхід D. D-тригер має 

інформаційний вхід D (вхід даних) і вхід синхронізації С. Вхід 

синхронізації С може бути статичним (потенційним) і 

динамічним. У тригерів зі статичним входом С інформація 

записується упродовж часу, при якому рівень сигналу C=1. В 

тригерах з динамічним входом С інформація записується тільки 

протягом перепаду напруги на вході С. Динамічний вхід 

зображають трикутником. На рис. 7.1 показана схема 

одноступінчастого D-тригера виконаного на логічних елементах 

І-НІ. 
 

 
Рис. 7.1. Принципова схема синхронного D-тригера на логічних 

елементах І-НІ 
 

Опис сутності D-тригера на мові VHDL: 

ENTITY d_flipflop IS 

PORT ( D, C: IN bit; 

            Q, NQ: OUT bit ); 

END ENTITY d_flipflop;   

Цей опис свідчить, що схема на ім’я d_flipflop має чотири 

зовнішні виводи (порти), з них два входи (IN): D та C; і два 

виходи (OUT): Q та NQ. Усі порти належать до типу bit, тобто 

сигнал на їх виводах може набувати значень ―0‖ і ―1‖. 

Опису архітектури D-тригера здійснюється через опис його 

поведінки. Даний D-тригер працює так, що при С=1, сигнал на 

виході Q повторює значення сигналу на вході D, а при С=0, 

тригер зберігає попередній стан і сигнал на виході Q не 

змінюється. Сигнал на виході NQ є інверсією сигналу на виході 

Q. 
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Поведінку тригера можна описати так: 

ARCHITECTURE behaviour OF d_flipflop IS 

BEGIN 

PROCESS (C,D) 

BEGIN 

IF  C = '1'  THEN 

     Q <= D  AFTER 5 ns; 

     NQ <= not D AFTER 5 ns; 

END IF; 

END PROCESS; 

END ARCHITECTURE behaviour; 

Оператор PROCESS (C,D) вказує на те, що робота схеми 

описується процесом, де зміна сигналів на виходах можлива 

лише внаслідок зміни вхідних сигналів C або D. Оператор IF 

визначає, що при C = '1', сигнал Q набуває значення D, а NQ – 

інверсії D. Ключове слово AFTER вказує на те, що вказані зміни 

значень на виходах Q, NQ відбувається не миттєво, а з 

затримкою на 5 наносекунд. 

Цей приклад, дає змогу уявити особливість використання 

типів даних, операторів та способів розробки простих проектів 

інтегральних схем на мові VHDL. Використання цієї мови 

сприятиме здобуттю практичних навиків у розробці 

інтегральних схем та опису їх поведінки. 
 

Програма роботи 

1. Розглянути особливість використання мови VHDL для 

розробки та моделювання поведінки інтегральних схем. 

2. Навчитися розробляти поведінкові програми інтегральних 

схем. 
 

Порядок виконання роботи 

1. Розглянути приклад розробки поведінкової програми з 

використанням мови VHDL, що описаний у теоретичних 

відомостях. 

2. Проаналізувати поведінку інтегральної схеми (варіанти схем 

приведені у Додатку 5) та розробити програму на основі 

мови VHDL. 
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3. Описати алгоритм функціонування розробленої програми. 

4. Результати роботи оформити у вигляді звіту. 
 

Контрольні запитання 

1. Які вимоги використання мов проектування? 

2. Що таке VHDL? 

3. Які типи даних використовуються у мові VHDL? 

4. Як виглядає розроблений на мові VHDL проект?  

5. Які оператори використовуються у мові VHDL? 

6. Яка особливість описів схем на мові VHDL? 

7. Наведіть приклад опису вхідних та вихідних сигналів на мові 

VHDL? 

8. Наведіть приклад опису архітектури на мові VHDL? 
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ДОДАТКИ 

Додаток 1 

Розміри листів паперу формату ISO 216 

Міжнародний стандарт на паперові формати ISO 216 

заснований на метричній системі мір і походить від формату 

паперового листа, що має площу в 1 м² (розмір А0). Всі формати 

паперу ISO мають одне і те ж відношення сторін, це відношення 

приблизно дорівнює 1:1,4142. Цей стандарт був прийнятий 

всіма країнами, за винятком США і Канади та деяких інших 

країн. 

Формат ISO 216 складається з трьох серій форматів (з 

близькими розмірами для однакових номерів): 

А - за основу прийнята площа в 1 м² для максимального 

аркуша серії. 

В - за основу прийнята довжина в 1 м для короткої сторони 

максимального аркуша серії. 

С - формати конвертів для листів серії А (розміри більші 

приблизно на 9%). 

 
Формат Серія A Серія B Серія C 

Розмір мм дюйми мм дюйми мм дюйми 

0 841×1189 33,11×46,81 1000×1414 39,37×55,67 917×1297 36,10×51,06 

1 594×841 23,39×33,11 707×1000 27,83×39,37 648×917 25,51×36,10 

2 420×594 16,54×23,39 500×707 19,69×27,83 458×648 18,03×25,51 

3 297×420 11,69×16,54 353×500 13,90×19,69 324×458 12,76×18,03 

4 210×297 8,27×11,69 250×353 9,84×13,90 229×324 9,02×12,76 

5 148×210 5,83×8,27 176×250 6,93×9,84 162×229 6,38×9,02 

6 105×148 4,13×5,83 125×176 4,92×6,93 114×162 4,49×6,38 

7 74×105 2,91×4,13 88×125 3,46×4,92 81×114 3,19×4,49 

8 52×74 2,05×2,91 62×88 2,44×3,46 57×81 2,24×3,19 

9 37×52 1,46×2,05 44×62 1,73×2,44 40×57 1,57×2,24 

10 26×37 1,02×1,46 31×44 1,22×1,73 28×40 1,10×1,57 
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Додаток 2 

Індивідуальні завдання  

 

Варіант 1 Варіант 2 

Варіант 3 Варіант 4 

Варіант 5 Варіант 6 
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Варіант 7 Варіант 8 

Варіант 9 Варіант 10 

Варіант 11

 

Варіант 12
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Варіант 13 Варіант 14 

Варіант 15 Варіант 16 

Варіант 17 Варіант 18 
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Варіант 19 Варіант 20 

Варіант 21 Варіант 22

 

Варіант 23 Варіант 24 
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Варіант 25 Варіант 26 

Варіант 27

 

Варіант 28

 
Варіант 29 Варіант 30 
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Додаток 3 

Індивідуальні завдання  

 



94  

 



95  

 



96  

 



98 
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Додаток 4 

1. Світлорегулятор 

 

2. Метроном 

 



99  

3. Стабілізатор напруги 

 
 

4. Стабілізатор напруги 
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5. Стабілізатор напруги 

 
 

6. Стабілізатор напруги 

 



101  

7. Реле вмикання освітлювальних ламп 

 
 

8. Електронний термометр 

 



102  

9. Термореле 

 
 

10. Стабілізатор 
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11. Комутатор 

 
 

12. Обмежувач струму 
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13. Пристрій захисту ПНЧ 

 
 

14. Підсилювач 

 



105  

15. Електронне реле 

 
 

16. Авометр 
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17. Генератор тону 

 
 

18. Мультивібратор 

 



107  

19. Автостоп 

 
 

20. Стабілізатор ЕДПС 
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21. Автостоп 

 
 

22. Підсилювач 
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23. Маніпулятор 

 
 

24. Генератор 
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25. Регулятор потужності 

 
 

26. Вимірювач 

 



111  

27. Генератор 

 
 

28. Вимірювач резонансу 

 



112  

29. Зарядний пристрій 

 
 

30. Зарядний пристрій для СЦА 
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Додаток 5* 

1. Асинхронний RS-тригер на логічних елементах АБО-НІ 

 
2. Асинхронний RS-тригер на логічних елементах І-НІ 

 
3. Синхронний RS-тригер на логічних елементах І-НІ 

 
4. Синхронний RS-тригер на логічних елементах АБО-НІ 
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5. Синхронний RS-тригер з динамічним керуванням на логічних 

елементах І-НІ 

 
6. Синхронний двоступеневий RS-тригер на логічних елементах 

І-НІ 

 
7. Комбінований D-тригер 
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8. Синхроний D-тригер виконаний на основі RS-тригера  

 
9. Двоступеневий JK-тригер  

 
 

10. Двоступеневий JK-тригер на логічних елементах І-НІ 

 
11. Комбінований JK-тригер 
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12. Чотирирозрядний лічильник-роздільник виконаний на основі 

мікросхеми типу ІЕ4 

 
13. Чотирирозрядний асинхронний лічильник-роздільник 

виконаний на основі мікросхеми типу ІЕ5 

 
 

14. D-тригер виконаний на основі мікросхеми типу ТМ2 
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15. D-тригер виконаний на основі мікросхеми типу ТМ5 

 
16. Чотирирозрядний лічильник-роздільник виконаний на основі 

мікросхеми типу ІЕ2 

 
17. Чотирирозрядний лічильник-роздільник виконаний на основі 

мікросхеми типу ІЕ1 

 
* 

Пояснення щодо принципу дії приведених схем детально 

описано у довіднику: Богданович М. И., Грель И. Н., 

Прохоренко В. А. Цифровые интегральные микросхемы. 

Справочник. Минск : Беларусь, 1991. 493 с. 

 


